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Overview

This manual covers the following topics related to your FLIR IP Series camera:

* Web browser configuration interface: See 2 Web Configuration Setup, page 2.

¢ Firmware upgrade tool: See 6 Firmware Upgrade Tool, page 55.

¢ Central Management Software for PC / Mac: See 7 Connecting to Cameras with
FLIR Cloud™ CMS, page 58.

¢ Smartphone / tablet apps: See 9 Smartphone and Tablet Apps, page 89.

Note

¢ For physical installation instructions, please refer to the Quick Connection Guide for your camera
model.

¢ Some settings described in this manual may not be available depending on the features supported by
your camera model.

¢ The following models have a different web interface and supporting software: DND13TL2, DNB14L2,
DNB13TL2, DNV14TL2, DNE14TL2, DNV14UX2, DNB14UX2. For instructions, please refer to the
respective manual for these cameras.
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Web Configuration Setup

The camera includes a built-in web interface that can be accessed using a web browser.

2.1 Supported Browsers

* Google Chrome™, Mozilla Firefox®, and Apple Safari® (via Webplugin)
* Microsoft Internet Explorer® 8.0 or later, 32-bit version (via ActiveX®)
2.2 Internet Explorer Setup

1. Open Internet Explorer® and enter the camera’s IP address in the address bar in the
following format: http://IP address:HTTP Port.

e For example: http://192.168.0.100:80

2. A notification bar appears asking if you would like to install ActiveX® plugins. Click In-
stall or Allow to install the plugins.

This webpage wants to run the following add-on: 'Flir Systems,Inc.’ from 'FLIR Systems, Inc..  What's the risk? Allow | v
]

®

3. Enter the camera user name (default: admin) and password (default: admin) and click
Login.

Usemame: ‘ admin

2.3 Safari Setup

1. Open Safari® and enter the camera’s IP address in the address bar in the following
format: http://IP address:HTTP Port.

e For example: http://192.168.0.100:80

2. A notification appears asking if you want to use the NPMedia plug-in. Click Trust to
use the plug-in.

Do you want to trust the website “192.168.50.117" to use
the “NPMedia plugin” plug=-in?

@ You can manage which websites you trust to use this plug-in in the
Security pane of Safari preferences.

[ '_:"' | Never for this Website | |  Trust | Not Now
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Web Configuration Setup

3. Enter the camera user name (default: admin) and password (default: admin) and click
Login.

-
—

Note

If video from the camera does not appear after installation, quit Safari® by right-clicking on the Sa-
fari® icon in the dock and then selecting Quit. Then restart Safari® and log back into your camera.

2.4 Firefox Setup

1. Open Firefox® and enter the camera’s IP address in the address bar in the following
format: http://IP address:HTTP Port.

¢ For example: http://192.168.0.100:80

2. A notification appears asking if you want to use the MMX plug-in. Click Allow... to use
the plug-in.

il Allow 192.168.50.152 to run "MMX"? Continue Blocking Allow.. | x

3. Enter the camera user name (default: admin) and password (default: admin) and click
Login.

f—
—

Note

If video from the camera does not appear after installation, quit Firefox® by closing the browser win-
dow. Then restart Firefox® and log back into your camera.

2.5 Google Chrome Setup

1. Open Chrome™ and enter the camera’s IP address in the address bar in the following
format: http://IP address:HTTP Port.

e For example: http://192.168.0.100:80

#L.X400038; r. 1.0/18537/18537; en-US 3



Web Configuration Setup

2. Click Please click here to download and install the plug-in.

€ Please click here to downioad and install the plug-in.

3. The plug-in downloads automatically. When finished, double-click the plug-in in the
downloads bar at the bottom of the browser window.

webplugin.exe

4. Enter the camera user name (default: admin) and password (default: admin) and click
Login.

Usemame: ‘ admin
Password: ‘ -----

Note

If video from the camera does not appear after installation, quit Chrome™ by closing the browser
window. Then restart Chrome™ and log back into your camera.

#L.X400038; r. 1.0/18537/18537; en-US 4



Live View

Upon login, the web interface opens to the Live View.

09-1T1T-2014 10:34:15 AM Thu

Note
Some functions are not available on all IP camera models, based on the features available.

1. Stream/Protocol Select: Allows you to select the video stream and protocol used in
Live View.

¢ Main Stream: Click to view the Main Stream. The Main Stream provides better pic-
ture quality and resolution, but requires higher bandwidth.

¢ Sub Stream: Click to view the Sub Stream. The Sub Stream is recommended for
better performance when viewing the camera over the Internet.

¢ Protocol: Select the protocol that will be used to stream video: TCP or UDP.

Note
Multicast is not supported.
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Live View

2. Video Display Controls

FTZ

Image Adjustment
305 e ) 64
O —10 64
P —0B 64
& 0

1. Brightness; 2. Contrast; 3. Hue; 4. Saturation

il Original Size: Click to view the video in its original size. This depends on the
resolution and if you are viewing the Main Stream or Sub Stream.

Full Screen: Click to view the video in full screen. Double-click or press ESC to
xit full screen mode.

=1 Width / Height Ratio: Click select Original to use the original proportions of
the image or Adaptive to adapt the image proportions to the size of the screen.
Realtime / Fluency: Click to select Realtime, Normal, or Fluency.

PTZ Controls (PTZ cameras only): Click to hide/show PTZ camera controls.
For details, see 3.1 PTZ Control Panel (PTZ Cameras Only), page 7.

3. Menu Tabs

Live: Click to access Live View.

PTZ: On micro PT cameras, the PTZ Control Panel is opened using the PTZ tab,
which replaces the button on the Video Display Controls panel.

Playback: Click to playback video from the camera’s microSD card (cameras that
support microSD only).

Setup: Click to setup camera functions.

Alarm: Click to configure alarms.

Logout: Log out of the camera.

#L.X400038; r. 1.0/18537/18537; en-US



Live View

4. Live View Functions

)

o Pen: Click the pen icon to activate the pen. Then, click-and-drag to draw lines
overtop of the video display. Click the arrow beside the pen icon to select the pen

',.,"n-l,.,

,"v 13
color (

.= Alarm Output: Click to activate an alarm output device connected to the cam-
era (cameras with alarm 1/O only).

* = Digital Zoom: Click to activate digital zoom mode. Then, click-and-drag in the
video area to select an area to zoom in.

o E Snapshot: Click to save a snapshot from the camera to your computer hard
drive. To configure the folder where snapshots are saved, see 5.1.8 Path, page 22.

Note

Depending on your computer’s security settings, you may need to run your browser as adminis-
trator to save snapshots or manual recordings.

J Triple Snapshot: Save the next three frames from the camera as snapshots.

. Manual Record: Click to start manually recording live video to your computer
hard drive. Click again to stop recording. To configure the folder where manual re-
cordings are saved, see 5.1.8 Path, page 22.

J Manual Focus (motorized lens cameras only): Click to display the AF Peak
and AF Max parameters for auto focus. The closer AF Peak and AF Max are, the
better the focus effect is. To configure auto focus, see 5.1.3 Zoom and Focus (Mo-
torized Lens Cameras Only), page 18.

. K2 Audio Output: Click to mute / un-mute audio coming from the camera (audio-
enabled cameras only; must have self-powered microphone connected to the
camera).

o Intercom: Click to activate the intercom to the camera (audio-enabled cameras
only; must have amplifier or speakers connected to the camera.

. @ Help: Click to access the built-in help file.

3.1 PTZ Control Panel (PTZ Cameras Only)
From Live View, click to open the PTZ control panel.

Note

The PTZ control panel only allows you to call pre-configured actions. To configure PTZ actions such as
preset locations and tours, see 5.3 PTZ, page 29.
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Live View

3.1.1 PTZ Controls

e Zoom e
lo Focus @
e Iris

PTZ Function

Click the arrows to move the camera

Click middle button and then click and drag on the video to move the camera
Adjust the camera speed

Adjust the zoom

Adjust the focus

Adjust the iris

o0k wh -~

3.1.2 Scan
You can use the Scan function to have the camera move automatically between two points.
To configure scan function:

1. Select Scan from the dropdown menu under PTZ Function.

PTZ Function

2. Click Start to begin the scan.

3.1.3 Preset
You can save preset positions in the camera to recall them later.
To go to a preset location:

1. Select Preset from the dropdown menu under PTZ Function.

PTZ Function

T

1

2. Enter the number of the preset you would like to move the camera to.
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Live View

3. Click Goto to move the camera to the preset location.

3.1.4 Pattern

You can use the pattern function to record a series of camera movements to recall later.
To run a pattern:

1. Select Pattern from the dropdown menu under PTZ Function.

2. Enter the number of the pattern you would like to move the camera to between 1~5.
3. Click Start to run the pattern.

3.1.5 Goto
The Goto function allows you to move the camera to a position with specified parameters.

To move the camera to a specified position:

1. Select Goto from the dropdown menu under PTZ Function.

PTZ Function

Horizontal Angle(0~3600)

Vertical Angle(0~800}

Zoom{1~128)

Gt

Enter the Horizontal Angle you would like to move the camera to between 0~3600.
Enter the Vertical Angle you would like to move the camera to between 0~900.
Enter the Zoom level between 1~128.

Click Goto to go to the specified position.

aokrwp

3.1.6 Pan
You can use pan to have the camera move horizontally between two positions.
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Live View

To start a pan:

1. Select Pan from the dropdown menu under PTZ Function.

PTZ Funclion

2. Click Start to begin panning.

3.1.7 Tour

Use tours to have the PTZ camera move automatically to several preset locations in a
cycle.

To start a tour:

1. Select Tour from the dropdown menu under PTZ Function.

FTZ Function

fowr I

2. Enter the number of the tour you would like to move the camera to between 1~8.
3. Click Start to begin the tour.

#L.X400038; r. 1.0/18537/18537; en-US
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Playback (Cameras with microSD
only)

Playback mode allows you to playback video from the camera’s SD / microSD card.

Note
Playback is only available if your camera supports on-board recording using an SD / microSD card.

To playback video from the microSD card:

1. Use the calendar to select a day to search for video. The bar on the bottom populates
with video recorded on that day.
2. Click in the time bar to start playback.

OR

1. Click in the calendar to select a day to search for video.

2. Click . A list appears with video files from the selected day.

#L.X400038; r. 1.0/18537/18537; en-US 11



Playback (Cameras with microSD only)

3. Click a time to select it.

Start Time Record Type
=

11:29:25
11:29:37
11:29:49
11:31:39
11:34:07
11:34:21
11:34:33
11:36:13

11:44:41
11:47.05

€ e e e e

11:4824

arippi coto [l D

Begin Time: 2013-09-20 11:27:21
End Time:  2013-09-20 11:27:37
File Size: 16335(KB)

4. Click [=] then [ to start playback.

4.1 Playback Controls

e T

B csmoEnn
: ooBno
 ppopooe
EDECmOD

Dme|
- DDDENn

Play
Stop
Next frame
Slow

1
2

3

4

5. Fast

6. Mute

7. Volume

8. Select playback time

9. Show / hide recording type in time bar
10. Zoom into time bar
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Playback (Cameras with microSD only)

4.2 Backing up Video Files

You can download video files to your computer hard drive. Video files are saved in (.dav)
format. You can use the video player available from www.flirsecurity.com/pro to play back-
up video files.

To backup video files:

1. Clickin the calendar to select a day to search for video.

2. Click . A list appears with video files from the selected day.

3. Click E next to the video file you would like to download to your computer’s hard drive.

Start Time Record Type
|

11:29:25
11:29:37
11:29:49
113139
11:34:07
13421
11:3433
11:36:13
11:44:41

11:47.05

L ]
L 4
+
4
+
4
+
L 2
+
+
4
L 4

11:4824

Marr coTo [l

Begin Time: 2013-09-20 11:27:21
End Time:  2013-09-20 11:27:37
File Size: 16335(KB)
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Setup

The Setup menus allow you to configure camera settings.

5.1 Camera

The Camera tab allows you to set the camera’s video and image settings.

5.1.1 Settings

The Settings menu allows you to configure the image sensor settings for the camera. As
you make adjustments, the effects will be shown in the video display.

> Video
Network
Event
Storage
System

Information

oetaut|[ Cancel [ save

Note

Profile | Normal

I

Brightness ~4¢{=] ——————{ }—————(£] 50
Contrast ( [j[=)————{}———(E 50
Saturation 74 (] = (] 50
Sharpness. /\[(=) e () 50
Anti-flicker @ Quidoor () 50Hz () 60Hz

Exposure  |Auto

I

White Balance  |AUt0

<

z
g
<

Day & Night
D&N Sensitivity

ol =
ol =

§
<] <

DEN Delay

[=}
il
=
<

BLG Mode

=
El
O
g

(® OFF

2
g
I

3DNR (@ ON CHOFF

3DNRLevel [T}

(=) s0

& CAUTION

Some camera models use a different interface to
configure the image sensor settings (shown on
the right). If the image sensor setting menu on
your camera appears this way, see 10 Appendix
A — Camera Conditions (Select models only),
page 126 for instructions on using this interface.

Configile | Normal

Wlode | Auto

Conditions Profile Management

To configure the image sensor settings:

1. Under Profile, select Day, Night, or Normal. You can configure the image sensor set-

tings differently for each profile, allowing you to quickly apply different settings if

required.
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Setup

2. Configure the following:

Brightness: Adjust the brightness of the image between 0 and 100.

Contrast: Adjust the contrast of the image between 0 and 100.

Saturation: Adjust the color saturation of the image between 0 and 100.
Sharpness: Adjust the sharpness of the image between 0 and 100. Higher sharp-
ness will make edges in the image clearer, but may increase noise in the picture.
Gamma: Adjust the gamma level of the image between 0 and 100. The gamma lev-
el controls the balance between dark and bright parts of the camera image. It is rec-
ommended to keep this value near the mid-point as a low gamma level can produce
a washed-out image, and high gamma can create a dark, oversaturated image.
Anti-flicker: Select the anti-flicker mode depending on the environment:

¢ Outdoor: The system will use the exposure mode to adjust for lighting.

¢ 50Hz: The system will compensate for lighting using 50Hz AC power (i.e. for
Europe).

* 60Hz: The system will compensate for lighting using 60Hz AC power (i.e. for
North America).

Exposure: Select the exposure mode.

¢ Auto: The system will automatically adjust the brightness and exposure based
on the environment.

¢ Low Noise: The system will automatically adjust the gain to reduce the amount
of noise in the image. Set the minimum and maximum Gain Scope. Increasing
the max gain will increase the noise reduction.

¢ Low Motion Blur: The system will automatically adjust the shutter to reduce mo-
tion trails in the image. Set the minimum and maximum Shutter Scope.

¢ Manual: Configure manual exposure settings. Configure the Shutter Regulate
and Gain Scope.

White Balance: Select the white balance mode.

¢ Auto: Automatic white balance.

¢ Sunny: White balance mode for daylight.

¢ Night: White balance mode for night time.

* Customized: Manual white balance. Use the sliders to configure the Red Con-
trol and Blue Control.

Auto Iris (auto iris cameras only): Select ON to enable auto iris or OFF to disable
auto iris. If your camera supports the auto iris feature and is installed outdoors, it is
recommended to select OUTDOOR.

Day & Night: Select one of the following day / night modes.

¢ Auto: Camera will automatically change between day and night mode based on
the lighting (recommended).

e Color: Camera will be in day mode at all times.

e B/W: Camera will be in black and white at all times.

BLC Mode: Select one of the following modes.

e BLC (Backlight Compensation):The camera automatically adjusts the expo-
sure for a clearer image in the darkest areas of the video. Click Default to use
default settings or Customized to adjust the BLC area. The darker the area you
select, the brighter the image will be.
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Example image for BLC setting

* WDR (Wide Dynamic Range):The camera compensates for changes in bright-
ness across the image to enhance the picture quality of both light and dark areas.
Adjust the WDR level between 1 and 100.

Example image for WDR setting

¢ HLC (Highlight Compensation):The camera dims the brightest areas of the im-
age to make them clearer. Adjust the HLC level between 1 and 100.

Example image for HLC setting

o Off: Disable this function.

* Mirror: Select ON to flip the camera left and right.
* Flip: Select one of the options to flip the image or 0° to disable. Note that 90° rota-
tions are not supported if the Main Stream is set above 720p resolution.
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¢ 3D NR: Select ON to enable 3D spatial noise reduction. Under 3D NR Level, click
+ /- or use the slider to set the noise reduction value. The higher the value, the
greater the noise reduction. 3D noise reduction accomplishes the same process for
moving objects as well, providing clearer images in low light conditions. Removing
noise from the camera image reduces your recording file size and makes videos
clearer and more detailed.

3D-DNR OFF 3D-DNR ON

T

f

.ﬁ‘"
.

.

.

Example image for 3D NR setting

5.1.2 Profile Management

The Profile Management tab allows you to set which Profile to use at what times. Choose
to use a single profile at all times, or set a schedule for the camera to switch back and forth
between Day and Night profiles. In order to get the full benefit of this feature, ensure you
have configured the Normal, Day and Night profiles in the Settings submenu. See 5.1.1
Settings, page 14 for details.
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To configure the condition profile:
1. Select one of the following options:

¢ Normal: Camera will use the Normal profile at all times.

camer conatons | protte wangerent |

> Video

Profile Management ~ (@)Normal () Full Time () Schedule

Network [ peut |[ Rewesn |[ save |
Event

Storage
System

Information

¢ Full Time: Select the profile the camera will use at all times.

camera Condions | profte uanagemen | N

’)'\}d z Profile Management () MNormal () Full Time ()Schedule
ideo

Always Enable Day w
ek

Event | Default | | Refresh | | Save
Storage

System

Information

* Schedule: Configure a schedule that the camera will use for Day (yellow) and Night
(black) profiles. Click and drag in the time bar to set the schedule.

Profile Management () Normal (O Full Time (®)Schedule
> Video
Network
event perod eting —— [ —
0:00 4:00 8:00 12:00 16:00 20:00 24:00
Storage
System [JDay M Night
Information [ peut || Reesn |[ s

5.1.3 Zoom and Focus (Motorized Lens Cameras Only)
For motorized lens cameras, you can use the Zoom and Focus tab to adjust the lens.

Note

This setting is only available on cameras with a motorized lens. Check the technical specifications for
your camera.
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constors [ e ersgenent | zoomsre o [

Network
Event
Storage
System

Information

e Zoom: Click + / - or use the slider to adjust the zoom level.

¢ Focus: Click +/ - or use the slider to adjust the focus.

¢ Auto Focus: Click to have the camera automatically adjust the focus to the currently
selected zoom level.

Note

Adjustments in this menu are automatically saved.

5.1.4 Video

The Video tab allows you to configure the encoding settings for the camera. Video settings
are divided into Main Stream and Sub Stream.

Camera Video EE=E Overlay | Path ©]
> Condiions
| vieo | MainStream Sub Stream
Network (¥ Enable
Event
ot s e o s e
Slorage Encode Mode H.264 v Encode Mode H.264 v
System
v Resolution 1080 (1920°1080) v Resolution CIF (352°240) v
Information
Frame rate(FPS)  [15 v Framerate(FPS)  [15 v
Bit Rate Type CBR v Bit Rate Type CBR v
Reference Bit Rate 2048-8192Kb/S Reference Bit Rate 96-512Kb/S
Bit Rate Bit Rate
4000

Watermark Settings
Watermark Character | FLIR

Default

[ Reesn [[  sae

To configure video quality settings:

1. Check Enable under Sub Stream to enable the sub stream or uncheck to disable.
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2. For the Main Stream and Sub Stream, configure the following:

e Code Stream Type: For the Main Stream, select General to configure settings
when motion is not detected or Motion to configure settings when motion is
detected.

* Encode Mode: Select the encoding type: H.264 (Main H.264 profile), H.264H
(High Profile H.264), H.264B (Baseline H.264 profile), MJPEG.

Note

A much higher bitrate and faster connection is required to maintain image quality using MJPEG.
It is recommended to use H.264 unless you have special requirements.

¢ Resolution: Select the desired resolution for the video stream. There is a different
recommended bit rate depending on the resolution selected.

Note
You may not set the resolution above 720p if the Flip function is activated.

¢ Frame Rate (FPS): Select the desired frame rate for the video stream between 1
and 30 FPS.

* Bit Rate Type: Select CBR (Constant Bit Rate) or VBR (Variable Bit Rate). If you
select VBR, you can select the Video Quality between 1 (lowest) and 6 (best).

* Reference Bit Rate: Recommended bit rate range based on the resolution and
frame rate settings you have selected.

* Bit Rate: Select the desired bit rate for each video stream or select Customized
and enter the bit rate in Kbps.

¢ | Frame: Select the interval for | frames. It is recommended to select 2 unless you
have special requirements.

3. Under Watermark Settings, check to enable watermark to protect against video
tampering.

4. Under Watermark Character, enter the desired watermark text.

5. Click Save to save changes.

5.1.5 Snapshot

The Snapshot menu allows you to configure images quality settings for snapshots.

Voo | swerer | oww 1 Pm

> Conditions

e R R—
Image Size 1080P (1920°1080)
Network
Qual
Event o
SnapshotStream (@ Main Stream (*)Sub Stream
Storage
e Interval 1s v
Information [ peur [[  Reesn [[  sae
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To configure snapshots:
1. Configure the following:

* Snapshot Type: Select General to configure snapshots taken using scheduled re-
cording. Select Event to configure snapshots activated by alarms.

* Image Size: The image size of snapshots is the same as the resolution for the
stream selected.

¢ Quality: Select the image quality for snapshots between 1 (lowest) and 6 (highest).

¢ Snapshot Stream: Select Main Stream to take snapshots from the Main Stream
or Sub Stream to take snapshots from the Sub Stream.

¢ Interval: Select the interval between snapshots between 1 and 7 seconds.

2. Click Save to save changes.

5.1.6 Overlay

The Overlay tab allows you to configure the text and information that appears overtop of
the camera image, such as time and date display.

Camera Video I ‘Snapshot I Overlay I Path -
= ALEAE20 2:34.07 PM Mo

> Se s

> Audio

» Prvacy Masking O Enatle @ Disabis

» Channel Tels Picturm i

» Time Tiie

» Toxm Ovarlay

Network
PTZ

Event
storage
System
Information

To configure video overlay:

1. Under Channel Title, click Enable to show the name of the channel on screen. Under
Input channel title, enter a personalized channel name.

2. Under Time Title, check to show the time. Check Week Display to show the day of
the week.

3. Under Text Overlay, click Enable beside the PTZ functions (for example, tours and
preset locations) you want to display on screen (PTZ cameras only). Under Input loca-
tion, enter a custom message up to 5 lines.

Preseti

Example image of Preset text overlay
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4. Click Save to save changes.

5.1.7 Privacy Masking

Configure privacy masks to hide certain parts of the camera image in video recordings.

& CAUTION

Privacy masks block out parts of the camera image entirely and appear as black boxes in recordings.

To configure video overlay:

1. Under Privacy Masking, select a number from the SN dropdown. Click Draw to cre-
ate a new privacy mask. You can create up to 24 privacy masks.

Camera Video I Snapshot I Overlay I Path _
' T N pac ack R : =

¥ Channel Title

» Time Title

Network
PZ

» 0SD

Event
Storage
System

Information

» Click the corners of a privacy area to adjust the size of the privacy area.
* Right-click to delete the currently selected privacy area.

¢ Click-and-drag outside of the privacy areas to create a new privacy area.
* Click Save to save changes.

5.1.8 Path

The Path tab allows you to configure the folder where snapshots and manual recordings
are saved to.

Camera Video I Snapshot I Overlay I Path I
> Conditions
Snapshot Path C:\PictureDownload
Record Path C:\RecordDownload
pefaut | [ save

Storage

System

Information

To configure the recording and snapshot folder:
1. Configure the following:

¢ Snapshot Path: The folder on your hard drive where snapshots are stored. Click
Browse to select a different folder.

* Record Path: The folder on your hard drive where manual recordings are stored.
Click Browse to select a different folder.

2. Click Save to save changes.
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5.1.9 Audio

The Audio tab allows you to enable / disable camera audio as well as choose the audio en-
coding type. The settings in this menu will affect both one-directional and bidirectional
audio for the camera.

Note

This setting is only available on cameras with a microphone. Check the technical specifications for your
camera.

Camera

Sub Stream

Enabla Enable

Encode Mode Encode Mode

Event

Storage

System

Information

To configure audio settings:

1. Check Enable under Main Stream, Sub Stream, or both to enable audio.
2. Under Encode Mode, select an encoding mode from PCM, G.711A and G.711Mu.
3. Click Save to save changes.

5.2 Network

5.2.1 TCP-IP

The TCP-IP menu allows you to configure the camera for DHCP or Static IP addressing.

Camera TCPNP

Network
omes Host Name IPC
Connection Ethemet Card |Wire(DEFAULT) v
PPPoE Mode () static (e)DHCP
DDNS MAC Address 90 .02 .a9 .12 . 6 . el
IP Filter IP Version IPv4 v
SMTP(Email) IP Address 192 . 168 . 1 . 107
UPnP Subnet mask 255 . 255 . 255 0
SNMP Default Gateway 192 . 168 . 1 1
Bonjour PreferedDNSSever | 8 = 8 . 8 . 8

LI AllemaleDNSServer | 8 . 8 . 8 . 8

8
EEERE ["] Enable ARP/Ping to set IP address service

QoS

| peut || Reesn [ save |

To configure IP address settings:

—_

Under Host Name, enter the Host Name for the camera up to 32 characters.

2. Under IP Version, select IPV4 or IPV6.

3. Under Mode, select Static or DHCP. If you select Static, configure the IP Address,
Subnet, Mask, Default Gateway, Preferred DNS Server, and Alternate DNS
Server.

4. Click Save to save changes.
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5.2.2 Connection

The Connection menu allows you to configure the camera ports and maximum connec-
tions to the camera. You must port forward the HTTP (default: 80) and TCP (default:
35000) port numbers on your router to enable remote connection to your camera.

Note

If you are not using an NVR and are setting up multiple cameras in the same network for remote access,
you must assign unique TCP and HTTP ports for each camera. Two cameras cannot share the same port
number.

Camera Connection
Network

Max Connection

(1~20)
> TCPAP

= TCP Port 35000 (1025~65534)
UDP Port 37778 (1025~65534)
> PPPOE
> DDNS HTTP Port 80
> IP Filter RTSP Port 554
[] HTTPs

> SMTP(Email)

> UPnP HTTPs Port

> SNMP

> Bonjour
> Multicast
> IEEE802

> QoS

To configure connection settings and ports:

1. Under Max Connection, enter the maximum number of devices that can connect to
the camera at the same time between 1 and 20.
2. Configure the following port settings:

¢ TCP Port: Enter the TCP (Client) Port number (default: 35000). The TCP port is
used to stream video to remote computers or mobile devices. The TCP Port must
be port forwarded to enable remote connection to your camera.

¢ UDP Port: Enter the UDP Port number (default: 37778). The UDP Port is used for
special applications only.

e HTTP Port: Enter the HTTP Port (default: 80). The HTTP Port is used to access the
camera’s web interface. The HTTP Port must be port forwarded to enable remote
access.

Note

If you change the HTTP Port to anything other than 80, you must enter colon (:) and the HTTP
port in your web browser to access the camera (e.g. http:/tomsmith.myddns-flir.com:85).

¢ RTSP Port: Enter the RTSP Port (default: 554). The RTSP Port is used for special
applications. For details on supported applications, see 5.2.13 RTSP Streaming
(Advanced), page 28.

3. (Optional) To enable HTTPS, check HTTPs On. To connect to the camera using
HTTPS, you must forward the HTTPS port (default: 443) on your router. You must also
connect to the camera using the following format:

* https://IP or DDNS address:HTTPS Port
* For example: https://tomsmith.myddns-flir.com:443

4. (Optional) To configure the HTTPS port, enter the custom port number under HTTPS
Port (default: 443).
5. Click Save to save changes.
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5.2.3 PPPoE (Unsupported)

5.2.4 DDNS

The DDNS menu allows you to set up the camera with a free FLIR DDNS account for re-
mote connectivity. You can register for a FLIR DDNS account at ddns.myddns-flir.com.

Camera DDNS

[] Server Type Flir DDNS v

Domain Name | myddns-fiir.com

Network
> TCPAP

> Connection

Usermname ‘
PPPOE

Password

IP Filter

SMTP(Email)
UPnP

SNMP

Bonjour

Multicast
IEEE802
QoS

To configure DDNS:

Under Server Type, check the checkbox and select FlirDDNS.

2. Under Domain Name, enter the Domain Name from the confirmation email you re-
ceived after registering for DDNS.

Under Username, enter the User Name from the confirmation email.

Under Password, enter the Password from the confirmation email.

5. Click Save.

—_

W

Note
It may take between 10~15 minutes for the DDNS server to update with your new DDNS address.

5.2.5 |IP Filter

The IP Filter allows you to create a white list of device MAC or IP addresses that can ac-
cess the camera. If you use the IP filter menu, devices that are not on the white list will not
be able to remotely connect to the camera.

Camera IP Filter @

Network
Trusted Sites
> TCPAP
Trusted Sites
> Connection

IP address /MAC address

> PPPoE
> DDNS

> SMTP(Email)

> UPnP
> SNMP
> Bonjour
> Multicast

> IEEE802
e

> QoS

Event | Default I ‘ Refresh | | Save
Storage

System

Note

If you enable the IP filter the camera will block any device that is not listed. Make sure the correct devices
are added to the list, or you may not be able to access the camera.
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To filter connections based on IP or MAC addresses:

1. Click Add IP/MAC.

2. Select IP Address or MAC Address and then enter the address of the device you
would like to add to the white list.

3. Click Save.

4. Check Trusted Sites.

5. Click Save to save changes.

5.2.6 SMTP (Email)

The SMTP menu allows you to set up email alerts for motion or alarms.

Camera SMTP(Email)
Network

SMTP Server
Port 587

> TCPIP

> Connection

> PPPOE L] Anonymity
S Totie Usemame
> IP Filter Password
s
> UPnP ‘ i
> SNMP Title Alert [¥] Attachment
> Bonjour Mail Receiver
> Multicast
> IEEE802
> QoS
— Interval 0 Second (0~3600)
Storage [] Health Mail Update Period | 60 Second(1~3600)

Information
[ vemm [ Rewesn |[  sae

To configure SMTP Settings:

Under SMTP Server, enter the SMTP server address.

Under Port, enter the Port used by the server.

Check Anonymity if the server allows anonymous logins or uncheck to enter creden-

tials to access the server.

Under Username, enter the user name of the sender’s account.

Under Password, enter the password of the sender’s account.

Under Sender, enter the sender’s email account.

If the server uses encryption, select SSL or TLS under Authentication.

Under Interval, select the interval for sending email alerts. The system will only send

email alerts after this interval has passed.

9. Check Health Mail to enable the camera to send health alerts. If you enable health
alerts, enter the interval in seconds under Update Period.

10. Click Email Test to send a test email using the settings you have entered.

11. Click Save to save changes.

wn =

© N oA

5.2.7 UPnP

UPnP allows you to map port numbers between the LAN and the Internet. Depending on
your router version, you may need to disable UPnP function.
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Mode Router State Mapping Failed

ol s ™ WebService TCP. 80 8080 Mapping Failed 4 e
> DDNS | PrivService TCP 35000 35000 Mapping Failed 2 —
> IP Filter ] PrivService uoP 37778 37778 Mapping Failed 2 e

™ RTSPSenvice Mapping Failed 2 -]

5.2.8 Bonjour

The Bonjour menu allows you to enable the Bonjour service to easily detect the camera on
a local network when using a Mac.

Camera Bonjour
Network
> TCPAP

™ Enable

Server Name | FLIR ‘

> Connection
PPPoE Default
DDNS

IP Filter
SMTP(Email)
UPnP

To enable / disable the Bonjour service:

1. Check Enable to enable Bonjour or uncheck to disable.

2. Under Server Name, enter the name of the camera that will show up when accessing
the camera through Bonjour in Safari.

3. Click Save to save changes.

To access the camera through Bonjour:

1. In Safari, click to open the Bookmarks menu.
2. Click Bonjour, the IP Camera will appear in the list.

Bonjour

l + | about:blank ¢

(Q~ Google )

COLLECTIONS
(L) History
[11] Bookmarks Bar (207)
[ Bookmarks Menu

Address Book

Bonjou

| Bookmark

About Bonjour

(3 All RSS Feeds
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3. Double-click the IP camera to open it in a browser tab.
5.2.9 SNMP (Unsupported)

5.2.10 Multicast (Unsupported)

5.2.11 802.1x (Unsupported)

5.2.12 QoS (Unsupported)

5.2.13 RTSP Streaming (Advanced)

RTSP streaming allows you to stream video from a specific camera using a web address.

It is an optional connectivity method used by 3rd party software applications.

Note

The instructions in this section are using VLC Media Player. VLC Media Player is a free software provided

at www.videolan.org. FLIR cannot provide support for VLC Media Player or any other 3rd party software.
Please contact the software vendor for technical support related to 3rd party software applications.
To connect to the video stream using VLC Media Player:

Open VLC Media Player.
2. Click Media>Open Network Stream.

—_

]| Playback Audio Video Subtitle To

¥]  OpenFile e )
P
[¥] Open Multiple Files... Ctrl+Shift+0
[ Open Folder. ctil-F
&) Open Disc. CurleD
[%5 Open Network Stream. . Cuil=N

=
B | Open Capture Device. Cub-C

Open Location from clipboard  Ctrl+V/

Open Recent Media »

Save Playlist to File, sy
Convert / Save... CtsR

() Strearm.., Ctilss

Quit at the end of playlist
@ Quit CurkeQ

'p IR RS
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3. Enter the RTSP address in the following format:

¢ rtsp://<username>:<password>@<IP address>:<port>/cam/realmonitor?channel=
<channelNo>&subtype=<typeNo>

* <username>: The user name of the IP camera (default: admin).

e <password>: The password for the IP camera (default: admin).

¢ <|P address>: The IP address of the IP camera.

Note

In order to view the RTSP stream over the Internet, you must port forward the RTSP port (default:
554) on your router to the camera’s IP address.

¢ <Port>: The RTSP port (default: 554) of the IP camera.

e <channelNo>: Enter 1.

* <typeNo>: Enter 1 for the Sub Stream of the camera or 0 for the Main Stream. It is
recommended to use the Sub Stream if connecting over the Internet.

The example below shows the correct format to connect to the Sub Stream on an IP
camera

¥l ple | @ipisc | %Enetwork | BB Capture Device
Network Protocol
Please enter a network URL:
| rtsp:/fadmin:000000@192. 168.50. 174:55%/cam;realmonitor 2channel = 18subtype =1| v

[ Show more options

Play || | cancel

4. Click Play. The video stream will open in VLC Media Player.
If it does not connect, check the following:

* Check that the syntax on the RTSP address is correct.

* Make sure the IP camera is connected to the network.

¢ If connecting over the Internet, make sure to use the remote IP address of the camera
and that the RTSP port is open.

5.3 PTZ

The PTZ submenu allows you to configure preset locations, patterns and tours for retrieval

at any time.

5.3.1 Preset

Presets will save a camera position for quick retrieval.
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> Function
Network
PTZ
>

Preset Title
Preset01
2 Presetd2 =] @
3 Preset03 (=] (-]

Pattern
Event
Pan

Storage

Privacy Mask
System
. PTZ Speed
Information

Idle Motion

Pawerlp + oo |[@renesn |[m ciear
PTZ Restart

Default

To add presets:

1. Under PTZ > Function, click Preset.

2. Use the PTZ controls below the camera image to move the camera to the desired
location.

3. Click Add to add the current location to the list of presets.

4. Click I next to the preset title that was just added to save the preset. You can now call
the preset location from the Live View tab using the PTZ control panel.

To delete presets:

* Click = next to the preset title you want to delete to remove it from the list.

5.3.2 Tour

Tours will cycle through a set of presets.

Camera Function

Network
» Preset Tour No. Tour Name: Delete

¥ Scan
» Paitern

Event
Pan

Privacy Mask
F Stan +. Add
S .

Ho. Preset Duration{s) Delete

Storage

System

Information

Powerlp

3

»

»

¥ Idie Motion
»

» PTZRestart
»

Default

+ 00 |[H sae || Reiiesn

To add a tour:

1. Under PTZ > Function, click Tour.

2. Click Add beneath the tour list to add a new tour.

3. (Optional) Double-click the tour name to enter a personalized name for the tour.

4. Click Add beneath the preset list to add a location to the tour. By default, the newly
added location will show the number “1” under the Preset column.

5. Double-click the number “1” under Preset to open a dropdown menu with all of your
saved preset locations. Select the preset number you want to use as the first location
in the tour.
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6. Repeat steps 4 & 5 for as many preset locations as you would like in the tour. When fin-
ished, press Save to save the tour.
You can press the Start button to test the tour, then Stop to stop the test.

To delete a tour:

* Click = next to the tour you want to delete to remove it from the list.

5.3.3 Scan

An auto scan automatically cycles between a set left and right limit.

Function
Network

PTZ Restart

» Preset Seanbe. 1 =
+ Tour speed [ =] e[ [£] 5
Event =
* Pan
Storage
¥ Privacy Mask
System )
= J » PTZ Speed
Information L
* Idie Motion
* PowerlUp
»
»

Default

To add a scan cycle:

Under PTZ > Function, click Scan.

Under Scan No., select the scan cycle you would like to configure.

Click Set.

Using the PTZ controls, move the camera to the leftmost point of the scan pattern you

want to set and click Left Limit.

5. Move the camera to the rightmost point of the scan pattern you want to set and click
Right Limit.

6. Under Speed, click -/ + or use the slider to set the speed of the scan cycle. Setting a
higher number means the camera will move faster between the left and right limits.

7. Press the Start button to test the scan cycle, then Stop to stop the test.

PN

5.3.4 Pattern
You can use the pattern function to record a series of camera movements to recall later.

Gamera Function
Network
PTZ
> Py

» Preset PattemNo. 1 4

o

» Scan

Storage Y
b Privacy llask

System

_ » PTZSpeed
Information
¥ Idle Motion
* PowerlUp
b PTZRestart

» Default

To save a pattern:

1. Under PTZ > Function, click Pattern.
2. Under Pattern No., select the pattern cycle you would like to configure.
3. Click Set.
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4. Press Start Record to start recording a pattern. Move the camera in the desired pat-
tern using the PTZ controls. When finished, press Stop Record.
5. Press the Start button to test the pattern, then Stop to stop the test.

5.3.5 Pan

Set the camera to pan continuously at a set speed.

> - Function
Network
. » Preset Pan Speed [=] ———{}—— 5
» Tour

Event

storage

System
» PTZSpeed

* Idie Motion

Information

¥ Powerlp
* PTZRestar
8+ Default

To setup auto-pan:

1. Under PTZ > Function, click Pan.
2. Under Pan Speed, click - / + or use the slider to set the panning speed.
3. Press the Start button to test the auto-pan, then Stop to stop the test.

5.3.6 Privacy Mask

Configure privacy masks to hide certain parts of the camera image in video recordings.

& CAUTION

Privacy masks block out parts of the camera image entirely and appear as black boxes in recordings.

Camera Function
Network
i » Preset SN 1 -
S b Tour Enable [
» Sean

. st
vent
storage AT

§ <l Prvacy Mask

system

.’_ ¥ PTZ Speed

» ldle Motion

Information

» PowerUp
» PTZRestart

i ) Default

To add a privacy mask:

—_

Under PTZ > Function, click Privacy Mask.

2. Under SN, select a number for the privacy mask you wish to setup. You can configure
up to 24 privacy masks.

3. Check Enable.

4. Click Draw. Click-and-drag on the camera image to draw the privacy mask over the

area you wish to hide.

To remove a privacy mask:

1. Under SN, select the number of the privacy mask you wish to remove.
2. Uncheck Enable to disable the privacy mask, or press Clear to delete.
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5.3.7 PTZ Speed

Set the speed for the camera’s Pan-Tilt-Zoom functions.

Camera Function
Network
PTZ

> Pro

» Preset

PTZ Speed i Low @ &)
i P i Low (@ Hiddle ) High

Event

Storage

system

Information
b Idle Motion

¥ PowerlUp
* PTZRestart
» Defauit

To set PTZ speed:

1. Under PTZ > Function, click PTZ Speed.
2. Click either Low, Middle, or High to set the speed of PTZ functions.

5.3.8 Idle Motion

You can set the camera to perform a certain action when it is left idle for a set period of
time.

Camera Function
Network
PTZ

>

b Preset Enatle []
b Tour Idle Motion (7) preset () Tour
) Scan ) Pattern

idle Time 10 Minute

Event

Storage

System

Information
¥ Idie Motion

+ Powerlp
} PTZRestart

b Default

To configure idle motion:

1. Under PTZ > Function, click Idle Motion.

2. Check Enable to enable the idle motion feature.

3. Select an idle motion for the camera. You can choose from Preset, Tour, Scan, or
Pattern.

Note

You must setup at least one of the corresponding functions to set it as the idle motion. For example,
you must setup at least one tour to select Tour as the Idle Motion.

4. Under Idle Time, set the time in minutes before the idle camera performs the set idle

motion.
5. Press the Start button to test the tour, then Stop to stop the test.

5.3.9 Power Up

Choose an action for the PTZ camera to perform when it first powers up.
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Camera Function
Network
» Preset Enable
HRCh PowerUp () Preset () Tour
¥ Scan DiScan  CPatiem
= » Patiem @ Auto:
Event E &
¥ b Pan
storage :
s Pald » Privacy Mask
» PTZSpeed
Information
b Idle Motion

» PTZRestart
¥ Default

To configure the power up function:

—_

Under PTZ > Function, click PowerUp.

2. Check Enable to enable the power up feature.

3. Select a power up function for the camera. You can choose from Preset, Tour, Scan
Pattern, or select Auto to perform the default PTZ diagnostic check on startup.

Note

For all options except Auto, you must setup at least one of the corresponding functions to set it as
the power up function. For example, you must setup at least one tour to select Tour as the power up
function.

4. Click Save to save your settings.

5.3.10 PTZ Restart
Restart the PTZ camera.

Camera Function
Network

» Preset
PTZRestart

» Tour

s » Frivacy Wask
g ||
= J_ s PTZ Speed

Storage

System

Information
* Idle Motion

» PowerUp

» PTZResfart

» Default

To restart the PTZ camera:

1. Under PTZ > Function, click PTZ Restart.
2. Click PTZ Restart.

5.3.11 Default
Set all PTZ functions back to the default settings.

’

& CAUTION

Resetting to defaults will erase any custom PTZ functions you have created — this step cannot be
undone.
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Gamera Function
Network

» Preset
Pz [Losn_|
. ¥ Tour
Prc

+ Scan
= » Patiem
Event

» Pan
Storage
oyets ¥ Privacy Mask
ystem

» PTZSpeed
Information

¥ idle Mation

+ PowerUp

» PTZRestart

To reset PTZ defaults:

1. Under PTZ > Function, click Default.
2. Click Default.

& CAUTION

Resetting to defaults will erase any custom PTZ functions you have created — this step cannot be
undone.

5.4 Event

5.4.1 Motion Detect
The Video Detect menu allows you to set up motion detection and recording.

Note

Recording functions require an FTP server or an on-board microSD card. Some camera models do not
support these recording features.

T T

Network
[ Enable
Workng oo
> Alam Anti-Dither |5 | Second(0~100)
> Waming Area
Storage
¥ Record
System
Record Delay | 10 | Second(10~300)
Information =
[ Relay-out
Alarm Delay | 10 | Second(10~300)
[] Send Email
[v] Snapshot

Defautt || Retesh ||  save

To set up motion detection settings:

1. Check Enable to enable motion detection.
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2. To configure a schedule when motion detection will be activated, click Setup next to
Working Protocol.

Working Period | %]

0 2 4 6 8 10 12 14 16 18 20 2 24

[C] Al | Sunday [ ] Monday [ | Tuesday [ | Wednesday [ | Thursday [ | Friday [ | Saturday
[v] Period 1: | 00 - 00 : 00 — 23 : 59 : 59
[] Period2: | 00 - 00 : 00 — 23 : 59 : 59
[ ] Period3: | 00 - 00 : 00 — 23 : 59 - 59
[[] Period4: | 00 - D0 : 00 — 23 : 59 : 59
[] Period5: | 00 - 00 : 00 — 23 : 59 - 59
[] Period6: | 00 - 00 - 00 — 23 : 59 : 59

[ swe |[ canca |

¢ Select the day you would like to configure by clicking the Setup buttons. You can
apply the same schedule to multiple days using the checkboxes.

¢ Configure up to 6 time periods when motion detection will be activated.

¢ Click Save. Repeat the steps above if you would like to apply a different schedule to
different

3. Under Anti-dither, enter the anti-dither time. After a motion event occurs and motion
stops, if motion is detected within the anti-dither time, the system continues the motion
event and includes the new motion within the first event, rather than creating a new
motion event.
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9.

10.

11.

To configure the motion grid, click Setup next to Area.

¢ Click squares on the grid to create motion detection areas. Click on the different col-
ors to set 4 different areas.

* To move an area, click inside and drag.

¢ Right-click to delete the selected area.

¢ Click-and-drag outside of all areas to draw a new area. You may have up to 4 motion
areas.

* Use the sliders to adjust the Sensitivity and Threshold for motion detection.

& CAUTION

Itis recommended to have someone moving in areas of interest on the camera image during
setup.

¢ The Sensitivity determines how sensitive the camera is to motion. For example,
if the sensitivity is high, small amounts of motion will score higher on the graph. It
is recommended to select a Sensitivity between 30~70.

¢ The Threshold determines how much motion is required to trigger an alarm or
recording. It is represented by the horizontal line on the graph. If the amount of
motion in the area exceeds this line, it will trigger an alert. It is recommended to
select a Threshold between 10~50.

e Each motion area can have a separate Sensitivity and Threshold value.

¢ Click Save.

Region | | e
Name | Region!
Sensitiity (=) ——{}——(H 60

Threshold (=)}

@5

SE==E

Check Record to record when motion is detected. microSD or FTP recording must be
configured to use this function.

Enter the number of seconds the camera will record after motion is detected under Re-
cord Delay.

Check Relay Out to trigger an external alarm device when the camera detects motion.
The camera must have an Alarm Output to use this function.

Enter the number of seconds before the camera will trigger the external device under
Alarm Delay.

Check Send Email for the camera to send an email alert when motion is detected.
Email settings must be configured to receive email alerts.

Check Snapshot for the camera to save a snapshot when motion is detected. mi-
croSD or FTP recording must be configured to use this function.

Click Save to save changes.
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5.4.2 Video Masking (Unsupported)

5.4.3 Relay Activation (Cameras with Alarm I/O Only)

The Alarm menu allows you to configure settings for alarm devices. Your camera must
have an alarm I/O connector to use alarm devices.

Camera Relay Activation
Network -
| Enable
Event
Relay-in Alarm1 v
> Video Detect
| dam | wewmorones
> Waring Anti-Dither 0 |second(0~100) SensorType [NO v
Storage _
] Record
System
Record Delay 10 Second(10~300)
Information '
¥ Relay-out
Alarm Delay 10 | Second(10~300)
[] Send Email
[] Snapshot

Default H Refresh H Save

To configure alarm device settings:
1. Configure the following:

¢ Under Relay-In, select the alarm device you would like to configure.

¢ Check Enable to enable the selected alarm In device.

¢ Click Setup next to Working Period to set a schedule for alarm device activation.

¢ Under Anti-Dither, enter the latch time in seconds.

¢ Under Sensor Type, select NO (Normally Open) or NC (Normally Closed) depend-
ing on the type of sensor used.

¢ Check Record to record when a sensor device is triggered.

* Under Record Delay, enter the amount of time the system will record when a sen-
sor device is triggered.

¢ Check Relay-out to activate an alarm output device (e.g. strobe light) when the
sensor device is triggered. The camera must have an alarm output to use this
feature.

¢ Check Send Email for the camera to send out an alert email when the sensor de-
vice is triggered.

¢ Check Snapshot for the camera to save a snapshot to FTP or microSD when the
sensor device is triggered.

2. Click Save to save changes.

5.4.4 No SD Card

A No SD Card error occurs if recording is set in the camera, but there is no SD / microSD
card installed.

Note

The No SD Card warning is only available on cameras that support SD / microSD cards. Check the tech-
nical specifications for your camera.
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No SD Card l Capacily Waming l SD Card Eror I Disconnection I 1P Conflict I
Network
] Enable
Event
] Relay-out
> Video Detfect y
Alarm Delay 10 Second(10~300)
> Alarm
[ Send Email
Storage Detaut | [ Rewesn || sae

System

Information

To configure No SD Card errors:

Check Enable to enable No SD Card errors.

2. Check Relay-out to trigger an alarm out device when No SD Card errors occur. Under
Alarm Delay, enter the number of seconds before the alarm out device will be
activated.

—_

Note

Relay-out is only available if your camera supports alarm output. Check the technical specifications
for your camera.

3. Check Send Email to send an email alert when No SD Card errors occur.

5.4.5 Capacity Warning

A Capacity Warning occurs when the recording destination (microSD / SD card or FTP
server) reaches capacity.

Camera No SD Card I Capacity Warning I SD Card Error I Disconnection l IP Conflict I
Network
[¥] Enable

Event g

Capacity Limit 1 %(0~99
> Video Detect i : 2

Relay-out
> Alarm ¥ Retay-o

m Alarm Delay 10 Second(10~300)

Storage [ Send Email
system Defaut || Retesh ||  sawe

Information

To configure Capacity Warnings:

—_

Check Enable to enable Capacity Warnings.

2. Under Capacity Limit, set the percentage of free space on the recording destination
that will trigger a Capacity Warning. For example, if you enter 10% and your microSD
card is 1GB, a warning will occur when there is only 100MB of free space remaining.

3. Check Relay-out to trigger an alarm out device when Capacity Warnings occur. Under

Alarm Delay, enter the number of seconds before the alarm out device will be

activated.

Note

Relay-out is only available if your camera supports alarm output. Check the technical specifications
for your camera.

4. Check Send Email to send an email alert when Capacity Warnings occur.
5. Click Save to save changes.

5.4.6 SD Card Error

An SD Card Error occurs if an error occurs recording to the SD / microSD card (for exam-
ple, if the card is damaged or is using the wrong file system).
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Note

The SD Card Error warning is only available on cameras that support SD / microSD cards. Check the
technical specifications for your camera.

» Camera NosDcad | CapactyWaming | spcararor | Disconnecton | 1P confict I
Network
[¥] Enable
Event
> Video Detect M g
Alam Delay 10 Second(10~300)
> Alarm
B st
Storage Default 1 | Refresh J | Save

System

Information

To configure SD Card Errors:

Check Enable to enable SD Card Errors.

2. Check Relay-out to trigger an alarm out device when SD Card Errors occur. Under
Alarm Delay, enter the number of seconds before the alarm out device will be
activated.

—_

Note
Relay-out is only available if your camera supports alarm output. Check the technical specifications
for your camera.

3. Check Send Email to send an email alert when SD Card Errors occur.
4. Click Save to save changes.

5.4.7 Disconnection

A Disconnection error occurs if the camera is disconnected from the network.

Camera No SD Card I Capacity Warning I SD Card Error I Disconnection I IP Confiict I
> Network
[] Enable
Event
] Record
> Video Detect i
Record Delay 10 Second(10~300)
> Alarm
[ wamng |
— Alarm Delay 10 Second(10~300)
System Default | | Refresh ’ E Save

Information

To configure Disconnection Errors:

1. Check Enable to enable Disconnection errors.
2. Check Record to record to the microSD / SD card when Disconnection errors occur.

Note

The camera must support microSD / SD card recording to use this function. Check the technical
specifications for your camera.

3. Under Record Delay, enter the number of seconds the camera will record after a Dis-
connection error.
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4. Check Relay-out to trigger an alarm out device when Disconnection errors occur.
Under Alarm Delay, enter the number of seconds before the alarm out device will be
activated.

Note

Relay-out is only available if your camera supports alarm output. Check the technical specifications
for your camera.

5. Check Send Email to send an email alert when Disconnection errors occur.
6. Click Save to save changes.

5.4.8 IP Conflict

An IP Conflict error occurs if another device is assigned the same IP address as the IP
camera.

Camera NosDCard || Capactywaming | socademor | Disconnecion | 1P confict ]
Network

[] Enable
Event

W Record
> Video Detect

Record Delay 10 Second(10-300)
> Alarm
[ vy |

Storage Alarm Delay 10 Second(10~300)
System Detaut || Reesh || sae

Information

To configure IP Conflict errors:

1. Check Enable to enable IP Conflict errors.
2. Check Record to record to the microSD / SD card when IP Conflict errors occur.

Note

The camera must support microSD / SD card recording to use this function. Check the technical
specifications for your camera.

3. Under Record Delay, enter the number of seconds the camera will record after an IP
Conflict

4. Check Relay-out to trigger an alarm out device when IP Conflict errors occur. Under
Alarm Delay, enter the number of seconds before the alarm out device will be
activated.

Note

Relay-out is only available if your camera supports alarm output. Check the technical specifications
for your camera.

5. Check Send Email to send an email alert when IP Conflict errors occur.
6. Click Save to save changes.

5.4.9 Network

Some cameras group the IP Conflict and Disconnection warnings into a single Network
warning tab.
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T I

Network
Event Type

["] Enable

> Video Delect

Storage

System

Information

To enable IP Conflict / Disconnection errors:

1. Under Event Type, select Disconnection or IP Conflict.
2. Check Enable to enable the selected warning type.

5.5 Storage

The Storage menu allows you to configure recording settings.

5.5.1 Record Schedule

Camers T srepsrotsancaue T rotaayscncove [

‘
Friday
PTTTT TTTTTTTT 1 11 LTTT

Saturday
5 5 O 5 5 10 i I [ 0 A

Holiday

Defaut | [ Reesn | [  sae |

Network
M General Motion W Alarm
Event 0 2 4 6 8 0 12 14 16 18 20 2 24
Storage Smday["i’i’i“\ I 1 1 5 5 15 i O 5 U O 5 01 L
‘-_{-""_ Mmd”\!!llmuluuw 1 1 1 0
> Destination o i ] L1 fommi 112; 0 I 1
S M| 1] LT I I [ 1
> Record Control
0 1 1 UV TT -
o Lo |
) 1 0 O IEEEE) Iy = e ) iy
Information Thursday

To configure the recording schedule:

1. Click Setup next to the day you would like to configure.
2. Use the checkboxes if you want to copy the schedule to other days.
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3. Configure up to 6 time periods for recording. For each period, enter a time range and
check the recording types you would like to enable during that period:

¢ General: Continuous recording.
¢ Motion: Motion activated recording.
e Alarm: Alarm activated recording.

Setup

— [] All v/ Sunday [ ] Monday [ | Tuesday

[] Wednesday [ ] Thursday [ | Friday [] Safrday [] Holiday

Period 1: | 00 : 00 : 00 — 23 : 59 - 59 i General Motion Alarm
Period2: | 00 : 00 : 00 — 23 : 59 : 59 | [ | General [ ]| Motion [ | Alarm
@— Period3: | 00 - 00 : 00 — 23 - 59 : 59 | [] General [ | Motion [ ] Alarm
Period 4: | 00 : 00 : 00 — 23 : 59 - 59 [] General [| Motion [] Alarm
Period5: | 00 : 00 : 00 — 23 : 59 : 59 | [] General [| Motion [ ] Alarm
Period 6: | 00 - 00 : 00 — 23 : 59 : 59 | [] General [ | Motion [ | Alarm
[ sawe || cance

d

3.1.  Check to copy schedule
3.2.  Configure up to 6 periods
3.3.  Enable recording types

4. Click Save.

5.5.2 Snapshot Schedule

The Snapshot schedule determines the schedule for snapshot recording.

Camera

Network
>

N General

Motion I Alarm

Storage

> Destination

> Record Control

System

Information

To configure the snapshot schedule:

1. Click Setup next to the day you would like to configure.
2. Use the checkboxes if you want to copy the schedule to other days.

—_
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3. Configure up to 6 time periods for recording. For each period, enter a time range and
check the recording types you would like to enable during that period:

¢ General: Continuous recording.
* Motion: Motion activated recording.

e Alarm: Alarm activated recording.

Setup | X |
@——Ij All ¥ Sunday [ ] Monday [ | Tuesday [ | Wednesday [ ]| Thursday [ ] Friday [ | Saturday [ ] Holiday
Period1: | 00 : 00 : 00 — 23 : 59 : 59 | [v] General Motion Alarm—@
Period2: | 00 : 00 : 00 — 23 : 59 : 59 | [ | General [ | Motion [ | Alarm
@— Period3: | 00 : 00 : 00 — 23 : 59 : 59 | [| General [ | Motion [ | Alarm
Period4: | 00 : 00 : 00 — 23 : 59 : 59 | [] General [] Motion [ | Alarm
Period5: | 00 : 00 : 00 — 23 : 59 : 59 | [] General [| Motion [ ] Alarm
Period6: | 00 : 00 : 00 — 23 : 59 : 59 | [ ] General [ ] Motion [ | Alarm
| sawe || cance
3.1.  Check to copy schedule
3.2.  Configure up to 6 periods
3.3.  Enable recording types
4. Click Save.
5.5.3 Holiday Schedule
The Holiday Schedule allows you to set certain days of the year as holidays.
Record Schedule | Snapshot Schedule | Holiday Schedule I
[] Record [] Snapshot
Event
Storage Calendar
Sun Mon Tue Wed Thu Fri sat
> Destination ‘T‘ ‘7‘ ‘-3—‘ IT‘ ‘_5“ ‘?‘ -7—‘
> Record Control ‘T ‘?‘ ‘E‘ ’?‘ ‘E‘ ‘G‘ 7‘
Sy, (1] [10] (7] [13] [10] [20] [1]
Information S
(22 (23] {24] 25 |26]27|]z2s]
(2] [0
I Refresh | | Save
To configure the holiday schedule:
1. Check Record or Snapshot to enable holidays for that recording type.
2. Use the calendar to select which days are holidays.
3. Click Save.
5.5.4 Path
The Path tab allows you to select if the camera records to microSD or FTP.
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Camera Path

Network
Record Snapshot
Event
Event Type Scheduled Motion Detect Event Type Scheduled Motion Detect

Local 1 M
FTP O [

Storage
> Schedule

System
Information

To select the recording destination:

1. Under Record or Snapshot, check Local to record to the microSD card, or check
FTP to record to FTP. For video recording or snapshot recording, you cannot record to
both microSD and FTP.

2. Click Save.

5.5.5 Local

The Local tab allows you to format or configure the microSD card installed in the camera.

Camera
Network

Free Capacity/Total Capacity
Disk1 Normal Read & Write — | 1019.9M/7598.1M

Event
Storage
> Schedule

> Record Conirol
System
Information

Read Only || Read & Wite H Hot Swap. H Refresh

¢ Click Read Only to set the microSD card on read only mode. This disables microSD
recording.

* Click Read & Write to enable recording on the microSD card.

¢ Click Hot Swap to unmount the microSD card if you would like to eject it from the
camera.

¢ Click Format and then click Yes to format the microSD card. The camera will reboot
once the format is completed.

5.5.6 FTP

The FTP tab allows you to set up settings for recording to an FTP server.

Camera Path I Local I FTP -

Network

Enable
Event
Server Address

Storage

ot 21 (0~65535)
> Schedule |

User Name anonymity
> Record Control Password
System Remote directory share
Information Emergency (Local)

Defal | | Refresh ‘ | Save

To set up FTP settings:
1. Check Enable to enable recording to FTP.
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2. Configure the following:

¢ Server Address: Enter the IP address or DNS address of the FTP server.

e Port: Enter the FTP server port number.

¢ User Name: Enter the user name for the FTP server.

e Password: Enter the password for the FTP server.

* Remote directory: Enter the recording directory on the FTP server (e.g. share).

Note

The recording directory must be located one level below the root directory. For example, share is
acceptable, but not share/recordings.

¢ Check Emergency (Local) to enable microSD recording if the FTP server cannot
be reached.

3. Click Save to save changes.

5.5.7 Record Control

The Record Control menu allows you to configure recording parameters for the camera.

Network

Pack Duration 8 Minute (1~120)
Event

Pre-event Record 5 Second (0~5)
Storage

Disk Full | Overwrite v|
> Schedule

Record Mode (®)Auto ()Manual ()Off

> Destination

Record Control Record Stream | Main Stream v|

System | Default H Refresh || Save

Information

To configure recording parameters:

1. Under Pack Duration, enter the duration in minutes that the camera will use to pack
video

2. Under Pre-event Record, enter the duration in seconds that the camera will pre-re-
cord before motion events.

3. Under Disk Full, select Overwrite to overwrite recordings when the recording medium
is full or select Stop to stop recording when the recording medium is full.

¢ Under Record Mode, select Auto to record according to the schedule, select Man-
ual to record continuously, or select Off to disable recording.

4. Under Record Stream, select Main Stream to record using the Main Stream settings,
or select Substream to record the substream.
5. Click Save to save changes.

5.6 System

5.6.1 General

The General menu allows you to configure general camera settings.
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D cone | oseane [

Network

Device Name Flir
Event e ——
Language
Storage
Video Standard
System
[ osen | [ reren | [_swe

To configure general camera settings:

Under Device Name, enter a name for the camera.

Under Language, select the language that will be used for the web browser interface.
Under Video Standard, select NTSC (North America) or PAL (Europe).

Click Save.

PN

5.6.2 Date & Time

The Date & Time tab allows you to set up date and time settings for the IP camera.

Camera cerem [ oatearee [

Network
Date Format Month-Day-Year v
Time Format 12-Hour-based System v

Event

Storage
syt Tine Zone
Pm— Current Time 09 - 19 -2013)| 03 - 57 - 07

e DST Enable
> Default DST Type (Upate ® Week
TE Start Time [Mar wv|[2nd v|[Sunday v 02 : 00 - 00
> Auto Mainiain End Time [Nov +v|[1st v|[Monday  w|| 02 : 00 : 00
> Upgrade Synchronize with NTP
Information NTP Server pool.ntp.org

Port 123

Update Period 10 Minute(0~30)

| Detaut |[ Reesh || save

To configure date & time settings:
1. Configure the following:

¢ Date Format: Select the date format.

¢ Time Format: Select the time format (12 hour or 24 hour).

* Time Zone: Select your time zone.

e Current Time: Enter the current time or click Sync PC to sync your IP camera to
your PC’s clock.

2. If your area uses Daylight Savings Time (DST) check DST Enable. If you enable DST,
configure the following:

* DST Type: Select Date to select a date for the time change or select Week to select
the week and day for the time change.
* Start Time and End Time: Enter the start and end times for Daylight Savings.

3. Check Synchronize with NTP to synchronize the camera clock with an NTP time
server. A constant Internet connection is required to use NTP. If you enable NTP, con-
figure the following:

¢ NTP Server: Enter the NTP server address.
¢ Port: Enter the port for the NTP server.
e Update Period: Enter the interval the camera will use to update the time.
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4. Click Save.

5.6.3 Account

The Account menu allows you to configure user accounts and user groups. The camera
can support up to 18 user accounts and up to 8 groups. User accounts must be assigned
to a group and inherit permissions from user groups, but an individual user account can be
given less permissions than the group.

The camera includes a unique admin account that cannot be deleted. The admin account
is the only one that can change permissions assigned to user accounts. Accounts given
permission to access the Account menu may change the password for other accounts. Ac-
counts not given permission to access the Account menu may not change any account
passwords, including their own. It is essential to change the password of the admin ac-
count from the default to prevent unauthorized access to your camera.

You may also check Anonymous Login to allow users to connect to the camera without
entering a user name or password. Users connecting anonymously are given limited ac-
cess to the camera: they may only view live video and the Alarm list.

Camera Account €
Network

[[] Anonymous Login

Event
User Name Group

No. Group Name Remark Modify Delete
1 admin admin 's account 8 —

Storage

System

> General
> Default
> Import/Export
> Auto Maintain

> Upgrade

Information —
Authority List

Live Playback Record control Backup Account Alarm
Log Search Clear Log Upgrade Auto Maintain General Video/Audio
Schedule/Destination  Network Abnormality Video Detect Defaultimport/Export  Conditions

To create a user account:
1. Click Add User.
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2. Configure the following:

Add User
@—— User Name
Password
C _| Confirm Password
() —oow
@—— Remark
@—— Authority List v Al
MiLive A
EP\ayback
IRecord control
v
MiBackup
[ swe |[ canca |

2.1. User Name: Enter a user name for the user. The user name can be up to 15
characters including letters, numbers, and underscores.
2.2. Password: Enter a password for the user account. Re-enter the password

under Confirm Password.

2.3.  Group: Assign the user account to a group. The user account will inherit per-
missions from the group, which will be updated under Authority List.
2.4. Remark: (Optional) Enter a description for the user account.

2.5. Authority List: Use the checkboxes to assign permissions to the user account.

3. Click Save.
To create a user group:

1. Click the Group tab.
2. Click Add Group.

Network
oo [ Anonymous Login

Event

User Name
storage

Remark.

user group

1 ‘administrator group

Information
Authority List

Live Playback Record control Backup
Log Search ClearLog Upgrade ‘Auto Maintain
Schedule/Destination  Network Abnormaiity Video Detect

Account Aam
General Video/Audio
DefaultimportExport  Conditions

#L.X400038; r. 1.0/18537/18537; en-US

49



Setup

3. Configure the following:

Add Group % |

@ — Group
@— — Remark

@— Authority List [ an

Clive A
DP[ayback
[JRecord control

v
DBackup
|  sae || cancel

3.1.  Group: Enter a name for the group.

3.2.  Remark: (Optional) Enter a description for the group.

3.3.  Authority List: Use the checkboxes to assign the default permissions for user
accounts added to this group.

4. Click Save.
To modify a user account or group:

1. Select the User or Group tab.

-

2. Click = next to the account or group you would like to delete.
3. Edit the account or group details and then click Save.
To delete a user account or group:

1. Select the User or Group tab.

-
2. Click ™ next to the account or group you would like to delete.

Camera Account €
Network

[] Anonymous Login

Event
User Name Group

No. User Name Group Name Remark Modify Delete
1 admin admin admin 's account 4

Storage

System
> General
> Default
> Impory/Export
> Auto Maintain

> Upgrade

Information

Authority List
Live Playback Record control Backup Account Alarm

Log Search Clear Log Upgrade Auto Maintain General Video/Audio
Schedule/Destination  Network Abnormality Video Detect Defaultimport/Export  Conditions
Add User

3. Click OK.

5.6.4 PTZ Settings

When connected to a FLIR NVR, FLIR IP PTZ cameras support camera control over
Ethernet cable, which means that setting up PTZ protocol information is not a requirement.
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If using a third-party IP PTZ solution that supports camera control through RS-485 wires,
use the PTZ Settings menu to configure the PTZ protocol information.

Step 1 — Choose the PTZ protocol:
1. Click the Network PTZ tab to choose the PTZ protocol.

Camera Network PTZ Analog PTZ

Network
Protocol DH-SD1 |4

Event

storage [ pemut || Reesh |[  sae

System
> Conlinues

> Account

> import/Export
> Auto Maintain
> Upgrade

Information

2. Under Protocol, select the protocol being used by your PTZ camera from DH-SD1,
PELCOD, PELCOD1, PELCOP, or NONE.
3. Click Save to save your settings.

Step 2 — Configure protocol information:

1. Click the Analog PTZ tab to configure the protocol information.

ORI

Network

Address

1
Baudrate 9600 ~

Event

Storage

Data Bit ) v
System

Stop Bit 1 v

> Continues

> Account e

> Default
> Import/Export

> Auto Maintain

> Upgrade

Information

Under Address, enter the address of the PTZ camera.

Under Baudrate, select the baud rate from the available options.
Under Parity, select the correct parity from the available options.
Click Save to save your settings.

akrwn

5.6.5 Default

Click the Default button and then click OK to reset the camera to default settings. The
camera will reboot.

Camera Default
Network

Event

Storage

System

> General
> Account

Default
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5.6.6 Import/Export

The Import/Export menu allows you to export your camera’s configuration or import a
saved configuration.

Import/Export
»

Backup Path
Event

Storage Import l | Export
System

> General
> Account

> Default

Import/Export

To export the camera’s configuration:

1. Click Export.
2. Select a location on your computer and then click Save.

To import the camera’s configuration:

1. Click Import.

2. Select the configuration file you would like to backup and then click Open.
5.6.7 Auto Maintain

The Auto Maintain menu allows you to reboot the camera manually or on a automatic
schedule. Rebooting the camera regularly ensures system stability. It also allows you to
automatically delete old video files.

Camera Auto Maintain

Network

[] Auto Reboot
Event

[] Auto Delete Old Files
Storage

System Manual Reboot

> General i

Refresh | |

> Account

> Default

> Import/Export

To manually reboot the camera:
¢ Click Manual Reboot and then click OK to reboot the camera.
To configure auto reboot:

1. Check Auto Reboot to set the camera to reboot automatically on schedule.
2. Select the day and time for the camera to reboot.
3. Click Save.

To configure auto delete:

1. Check Auto Delete Old Files.
2. Enter the number of days the camera will retain video files.
3. Click Save.
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5.6.8 Upgrade

The Upgrade menu allows you to upgrade the camera firmware. When firmware upgrades

are released, they are available for free from www.flirsecurity.com/pro.

Camera
Network

> Select Firmware File

Storage

system

> General
> Account
> Default

> Import/Export

To upgrade the camera firmware:

1. Download and extract the firmware from www.flirsecurity.com/pro.

2. Click Browse.

3. Select the firmware file on your computer and then click Open.

4. Click Upgrade. The camera will upgrade the firmware and then reboot.

5.7 Information

Camera Online User
Network

User Loca Group
1 admin admin 192.168.0.104 2013-09-19 15:55:58

Event
Storage
System
Information

> Version

> Log

5.7.1 Version

The Version menu shows you information related to the product and firmware version.

Camera Version
Network

Device Type N133EB

Event
Software Version 2420 FLOD.0.R, build : 2014-09-28

Storage

WEB Version 3.2.4.216977
System
i DONVIF Version 241

> Log
Copyright 2014,All Rights Reserved.
» Online User

5.7.2 Log

The Log menu allows you to view system logs for the camera.
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Camera Log @
Network

Event Start Time | 2013 - 09 - 18 || 15 : 59 - 04 End Time | 2013 - 09 - 19 || 15 - 59 - 04

storage ] TN | |

Information

> Version

> Online User

Detailed Information

M€ 1p pGoTo| |(B)

e

To view system logs:

1. Under Start Time and End Time, enter the start time and end time for your search.

2. Under Type, select the type of log you would like to search for: All, Setting, Data,
Event, Record, Account, and Clear Log.

3. Click Search.

¢ (Optional) Click Backup to save logs to your computer hard drive.
¢ (Optional) Click Clear to delete all system logs.
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To perform a firmware upgrade over the LAN or Internet, a Config Tool is provided on the
CD or www.flirsecurity.com/pro. In an effort to continuously improve the functionality of our
products, firmware upgrades are available as a free download on www.flirsecurity.com/pro.

Note

The Config Tool is supported on PC only. Firmware upgrades can also be completed using the web
browser interface (see 5.6.8 Upgrade, page 53).

6.1 Installing a Firmware Upgrade Over the LAN
Prerequisites:

e Connect your IP camera to a router or switch on your network.
¢ Download a firmware upgrade from www.flirsecurity.com/pro, if one is available. Extract
the contents.

To perform a firmware upgrade over the LAN:

1. Download the Config Tool from www.flirsecurity.com/pro.

2. Extract the contents into a folder.

3. Open the folder and right-click ConfigTool.exe and Run as administrator. If a Win-
dows Firewall warning appears, click Allow Access. The Config Tool scans your LAN
for IP cameras.

4. Click Upgrade.

T8 ConfigTool (SRR )

Device List

Port | Subnet Mask | Defanl Ga . | Mae Address [Device - [Hup
0.0.18 000 255.255.265.0 10.0.0.1 90:02:48:6e T 1 WEE 100
D01 446 207 :8403/84 20014812, 9002 49:Be T 1h WVRE 100

SN | I Adiress I
T

5. Check any IP cameras you would like to upgrade.
6. Click Open. Select the upgrade firmware file (.bin).
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7. Click Upgrade. Wait for the upgrade to complete. Do not power off the system or
disconnect the power cable during upgrade. The system will restart when the up-
grade is complete.

| ol = — d
@ ConfigTool = e
Device List
]| 1P Address Port | Mac Address Upgrade Status Remark
1 [] 100019 35000 90:02:29:8¢:c7:1b
[ 2001:da8:207::9403/64 35000 90:02:a9:8c:c7:1b
1:\Digimerge_NVR 38xx_EngFrn_NP_Flir_Vz Open Upgrade Add Return

7.1.  Check IP cameras
7.2. Click Open and select firmware file
7.3. Click Upgrade
6.2 Installing a Firmware Upgrade Over the Internet

Prerequisites:

Port forward the Client Port (default: 35000) on the IP camera’s local router.

Obtain the public IP address of the IP camera.

Download a firmware upgrade from www.flirsecurity.com/pro, if one is available. Extract
the contents.

Download the Config Tool from www.flirsecurity.com/pro.

Extract the contents into a folder.

Open the folder and right-click ConfigTool.exe and Run as administrator.

Click Login.

Under IP Address, enter the public IP address of the IP camera. Edit the User Name,
Password, or Port if these have been changed from the default values.

N

IP Address: I

User Name: I admin|

Password:

Port: ] 35000

6. Click Login. The Config Tool logs in to the IP camera.
7. Click System Upgrade.
8. Click Open. Select the firmware file (.bin).
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9. Click Upgrade. Wait for the upgrade to complete. Do not power off the system or
disconnect the power cable during upgrade. The system will restart when the up-
grade is complete.

NetHork Paraneter | FPPOE| Systen Tnfornation| Systen Uperade

Upgrade Information -

Upgrade Fie: | _open | '_< : )
Current Progress: | !
— um,&;@

Save Return

9.1. Click System Upgrade
9.2. Click Open and select the firmware file
9.3. Click Upgrade
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Connecting to Cameras with FLIR
Cloud™ CMS

FLIR Cloud™ Client is a central management software that allows you to view and man-
age multiple FLIR security systems on a PC or Mac. It includes support for FLIR Cloud™
Services, allowing a simple, secure connection to compatible systems over the Internet
with no network configuration required.

7.1 System Requirements

Your system must meet the system requirements below:

Description Requirement

CPU Core 2 Duo 3.0GHz

Operating System Windows™ 8/7/Vista
Mac OSX 10.7 and above

Memory 2GB

Video 512 MB of video memory and above

Network (LAN) 10/100 BaseT Network

Network (WAN) 1 Mbps upstream
High-speed Internet service is required to remotely
connect to your system.

7.2 Installing FLIR Cloud™ Client
1. Download and install the client software.

e PC Users: Download and install FLIR Cloud™ Client for PC from
www.flirsecurity.com/pro.

e Mac Users: Download and install FLIR Cloud™ Client for Mac from
www.flirsecurity.com/pro. Double click to extract the software. Then, drag
the software to Applications.

€))

2. Once installation is finished, double-click the FLIR Cloud™ Client icon (#===) from the
desktop or Applications list.
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3. Log into the Client Software using the Client Software user name (default: admin) and
password (default: admin) and then click Login.

$FLIR

User Name: admin
Password: ssees
Remember Password

\ \
LLw:-gin 1\ Exit |

7.3 Adding a Camera over the Local Network (LAN)

You can add cameras over a local network (LAN). The software will automatically scan the
network for compatible cameras.

Prerequisites:

¢ Connect the IP camera to a router or switch on the network.
¢ |Install FLIR Cloud™ Client on a computer in the same network as the IP camera.

To add a camera over the LAN:

1. Click and then click B

2. The client scans your LAN for connected cameras. Check your camera (a) and click
Add (b).

3. Enter the password for your system (default: admin) and click OK.

4. Click then .
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5. Click-and-drag Default Group to the display window to open your camera in live view.

7.4 Adding a Camera over the Internet using a DDNS Address

It is recommended to sign up for a free FLIR DDNS address to connect to compatible
cameras over the Internet.

Prerequisites:

¢ Create a DDNS account at http:/ddns.myddns-flir.com.

¢ Input the DDNS address into the IP camera locally.

e Port forward the required ports on the router to the camera’s local IP address.
* Install FLIR Cloud™ Client on a remote computer.

To add a camera using a DDNS address:

1. Click and then click .
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2. Click Add Device.

TET @ D D

3. Enter the following:

Add Device
inputinfp —m8 —
Device Name: Tom's Camera W onvif
Group Name:| Default Group By IP/Domain

Type: | 1PC

Retrieve Info

Device Information

3.1.  Check By IP/Domain to add a camera using the DDNS address.

3.2. Device Name: Choose a name for your camera of your choice.

3.3. IP/DDNS Address: Enter the Domain Name/URL Request you received in the
email when you registered for DDNS followed by .myddns-flir.com.

Note

For example, if your Domain Name/URL Request is tomsmith, enter tomsmith.myddns-flir.
com

3.4. Client Port: Enter the camera’s Client Port.
3.5. User Name: Enter the camera’s User Name (default: admin).
3.6. Password: Enter the system’s Password (default: admin).

4. Click Add.

5. Click then .
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6. Click-and-drag Default Group to the display window to open your camera in live view.

Congratulations! You can now connect over the Internet to view and playback video on
your computer.

Result
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or Mac

FLIR Cloud™ Client allows you to connect to multiple systems from a PC or Mac.

8.1 Home Page

The Home Page allows you to access all the tabs within the software. Each tab allows you
to access different features.

To open tabs:

Click a tab from the Home Page to open it or click the button at the top of the screen
from within any tab to open a new tab.

8.2 Live View
The Live View tab is where you can view live video from connected systems.

To view live video from a system:

-
1. Click and then click to create a Live View tab.

2. Click and drag a DVR, NVR, group, or individual camera to open live video. To access
individual cameras, you can click + to expand groups or systems.

EnEEEODEoO@E =
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8.2.1 Live View Controls

1. Live display: Double-click to expand the area. Right-click to access additional options.
Hold the mouse over the display area to access the camera toolbar.

SoddOOD

Camera toolbar:

Sub Stream|

1.1. Streaming quality: Shows the bitrate and resolution for the stream, and shows if display is
showing the Sub Stream or Main Stream.
1.2 Manual recording: Click to start/stop manual recording.

1.3. Snapshot: Click to save a snapshot.
1.4. Mute/unmute: Click to mute/unmute audio (audio camera required).
1.5. Not supported.

1.6. Instant playback: Plays back the most recently recorded video from the camera. By default, it
will play back the last 5 minutes of recorded video from the camera.
1.7. Digital zoom: Click to enable digital zoom mode. Click and drag over the display area to zoom

on the camera. Then click and drag to pan. Click the icon again to zoom out.
1.8. Disconnect.

2. Split-screen mode: Click to select split-screen layout.

3. Aspectratio: Use the drop down menu to select the aspect ratio for the selected
camera. Original uses the actual aspect ratio of the image. Full-win stretches the im-
age to fill up the entire display area.

4, m Full-screen: Click to open full-screen mode. Press ESC to exit full-screen mode.

#L.X400038; r. 1.0/18537/18537; en-US 64



Using FLIR Cloud™ Client for PC or Mac

i
5. = Save view: Click to save the current display layout and open cameras as a view.
Then enter a name for the view.

6. . Start/stop tour: Click to start the tour. During the tour the client will cycle through
all saved views every few seconds. Click again to stop the tour.

7. PTZ Controls: Controls for PTZ cameras (not included). See 8.3 Controlling PTZ
Cameras, page 66 for details.

8. View: Click View to access view menu. Then double-click on a view to open it in the
display area.

Device L
View ~

|i Viewl

[—] -
l. View2

9. Devices: Shows a list of groups, cameras, and systems connected to the client. Drag
items to the display area to open live video. Right-click to view additional options.
8.2.2 Opening Live View in Multiple Monitors

If your computer has multiple monitors, you can open more than one Live View tab and
move them to secondary monitors. This allows you to monitor cameras on multiple moni-
tors at the same time.

Note

Using multiple monitors significantly increases the amount of computing resources necessary to run the
application and may affect performance.

To open Live View in multiple monitors:

-
1. Click and then click to create a Live View tab.
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2. Click and drag the tab outside of the client window to create a new window. You can
drag the window to one of the secondary monitors.

8.3 Controlling PTZ Cameras

If you have PTZ cameras (not included), you can control them using the client.

Note

You must ensure the PTZ camera is properly connected to your system and your system is configured to
detect it before you can control them using the client.

To control PTZ cameras:

* Click the display area with the PTZ cameras and use the on-screen PTZ controls.
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PTZ controls:

1. Open menu: Click to open camera OSD menu controls. This feature may not be sup-

ported for all camera models.

2. Move camera: Click the arrows to move the camera.

Click B3 to open dynamic zoom mode. Then click and drag in the video area to zoom

in the camera on an area.

Zoom +/-: Click to zoom the camera in and out.
Focus +/-: Click to increase/decrease the focus.
Iris +/-: Click to increase/decrease the iris.
Advanced: Click to access advanced PTZ controls.

ook

8.3.1 PTZ Presets
Presets will save a camera position for quick retrieval.

To add presets:

1. Click - to open the Advanced controls. Select Preset.

2. Click .
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3. Select the number of the preset you would like to add.

4. Move the camera to the desired position.

5. Click - to save the current position as a preset.

To go to a saved preset:

1. Select the preset number from the list or click . to go to the currently selected
preset.

8.3.2 PTZ Tours
Tours will cycle through a set of presets.

To configure a PTZ tour:

1. Click - to open the Advanced controls. Select Tour.

2. Click .

1 R =

3. Under Cruise ID, select the number of the tour you would like to configure.
4. (Optional) Under Cruise Name, enter a name for the tour.
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5. Use the chart to select which presets you would like to include in the tour and the order
of presets.

Tour List

Cruise Name

Time(s) ‘Operation

10

10

¢ Preset: Select the preset number.
¢ Time(s): Enter the time in seconds the camera will remain on the selected preset.

e Operation: Click . to add a preset to the tour. Click . to delete a preset from
the tour.
6. Click OK to save changes.

To run a PTZ tour:
1. Select the tour number and click .

8.3.3 PTZ Pattern
Patterns automatically cycle the camera between two positions.

To create a pattern:

1. Click - to open the Advanced controls. Select Pattern.

2. Select the number of the pattern you would like to set up.

3. Move the camera into the desired start position.
4. Click - to start recording the pattern.

5. Move the camera to the desired end position. Then, click - to stop recording the
pattern.

To run a pattern:

1. Select the pattern number and click .
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8.3.4 PTZ Scan
Scan automatically cycles between a left and right point.

To set up scan mode:

1. Click - to open the Advanced controls. Select Scan.

2. Move the camera to the desired left position and click .

3. Move the camera to the desired right position and click -

To run scan mode:

1. Click .

8.3.5 PTZPan
Pan makes the camera continuously pan 360°.

To run Pan mode:

1. Click - to open the Advanced controls. Select Pan.

2. Click .

8.4 Playback
You can use Playback mode to playback video saved on systems connected to the client.

To access Playback mode:

o
* Click and then click 2 to create a Playback tab.
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To playback video:

—_

Check the channels you would like to play back from in the Device List.
2. Under Type, check the file types you would like to search for.

e All: All recordings.

¢ General: Continuous recordings.

e MD: Motion recordings.

e Alarm: Alarm recordings. Your system must support alarm devices (not included) to
use this feature.

3. Under Stream, select Main Stream to search for Main Stream recordings (high qual-
ity) or Sub Stream to search for Sub Stream recordings (smaller file size).

4. Select the start time and end time for your search under From and To. You may not
search more than 24 hours of video.

5. Click Search. Wait for the client to find video saved to the system.

6. Click inside the play back bar to start playback.

» x . L — Ba X

2014-04-28
1 2 3 4 5 6 7 8 5 10 11 2 13 14 15 16 17 18 19 20 21 22 23

S T T TRV,
e T
T
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8.5 Playback Controls

PO

15.

$FLIR 4 0 -
HOME PAGE PLAYBACK LIVEV ADD
Main stream(1750 ) af x P72 0 0 A

Frart

Display area: Double-click to expand/return to split-screen mode. Hold the mouse
over the display area to open the camera toolbar.

§ =

Main Streami173(

. E Snapshot: Click to save a snapshot.

. Digital zoom: Click to enable digital zoom mode. Then, click and drag to zoom in. Click and

drag to pan the camera. Click again to zoom out.

Event: Click to view recordings based on a list of events and files.

Record: Click to view recordings on a timeline.

Sync: Click to sync playback between channels. This forces all channels to playback
from the same time.

Pause/play.

Stop.

Frame-by-frame: Click to advance the video by a single frame.

Playback speed: Use the slider to adjust the playback speed.

Mute.

. Volume.

. Split-screen: Select split screen configuration.

. Full-screen: Click to open playback in full-screen. Press ESC to exit full-screen.

. Timeline zoom: Use the slider to zoom in/out on the timeline.

. Playback timeline: Shows recordings from the selected channels on a timeline. Click

inside the timeline to start playback or select a playback time. Each type of recordings
is shown in a different color. Continuous recordings are green, motion recordings are
yellow, and alarm recordings are red.

Video clip: Click to start a video clip. You can download video clips to your hard drive.
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16. Download list: Click to see a list of files you have downloaded and the progress of
files that are currently downloading.

17. Search: Search for video on the selected channels based on the search parameters
you set.

18. Device list: Select the channels you would like to search or playback video from.

8.6 Downloading Video to your Computer Hard Drive

You can download video to your computer hard drive to save important events or share
them. It is recommended to download video of important events as soon as possible to en-
sure they are not overwritten by new recordings.

Note

PC Users: You may need to run FLIR Cloud™ Client as an administrator to download files to your hard
drive.

To download video files:

1. Start playing back video using the steps in 8.4 Playback, page 70.

2. Click . to start a video clip at the current playback time. Click . to stop the video
clip.

3. Configure the following save options:

File Format

‘Download Vidzo Plaver

(RE T o I - )

e Path: Use the default save folder or click Browse to select a different folder.
¢ File Format: Select Original Format to save to .dav format (requires the video
player). Select AVI to save files to .avi format (can be played in VLC Media Player).

Note
The Mac version only supports downloading video to .dav format.

¢ Download Video Player: Check to save a copy of the video player with the down-
loaded file.

4. Click OK to start the download. A status screen will pop up to show progress on down-
loaded files.

Note
To retrieve downloaded video files:

¢ PC Users: Browse to the folders listed in General>File.

* Mac Users: Browse to the folders listed in General>File. To get to the default location, open Applica-
tions in Finder, right click on FLIR Cloud Client and select Show Package Contents. Then, navigate
to the desired folder.

eoe (& Applications
e EEo=EIE 2= G

FAVORITES ame 4 Date Modified
£} Niles % FUR Cloud Clent ———
= All My Fil & Flir MAC Player Locl r
= il  Font Baok Show Package Contents
JRRETEITRNS @ Game Center
= Move to Trash
[ Desktop © iBooks n
[ Documents 2 Image Capture Get Info i
© Downloads i isms Compress “FLIR Cloud Client” »
=S D Munes Burn “FLIR Cloud Client” to Disc... Y
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8.7 Alarm

The Alarm menu allows you to view a list of alarms received by the client software.

Note

You must set up alarms in the Alarm CFG menu before they will appear in this list. See 8.12 Alarm CFG,
page 79 for more details.

To access Alarms:

[)
e Click and then click .

Alarm menu overview:

1. Number of alarms: Shows the number of open alarms.

2. Alarm list: Shows the list of alarms and information on when they occurred and which
systems and channels triggered them.

3. Alarm Process: You can close alarms by selecting one of the options and clicking OK.

4. Options: Check to enable the following:

* Display Link Video: Open live video to monitor alarms on a continuous basis.
* Display Overlay Window: Show the overlay controls. They allow you to enable/dis-
able sound alerts and quickly jump back to the Alarm menu from another tab.

. S
y 8

¢ Pause Refresh: Stop refreshing the live video in the video popup.

8.8 Log

The Log menu allows you to view logs for the client software or to view logs for connected
systems.

To access logs:

e (Click and then click .
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To view client logs:

1. Click Client Log to view logs for the client software.

2. Configure the following:

» Start Time/End Time: Select the start and end times to search for logs.
* Log Type: Select the type of logs to search for.

3. Click Search.
To view logs from connected systems:

1. Click Device Log to view logs from connected systems.

2. Configure the following:

e Start Time/End Time: Select the start and end times to search for logs.
¢ Log Type: Select the type of logs to search for.
* Device Name: Select the system you would like to view logs from.

3. Click Search.

8.9 E-map

E-Map allows you to place cameras over a still image. For example, you can use the E-
Map to create a virtual map of your cameras over a floor plan of your home or business.

To create an E-map:

1. Click and then click ﬂ
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2. Click Add Map.

Ciick Adato setup an Etap(| 4 AdSMap

3. Configure the following:

Add Map X

Name: Home

Picture;| floorplan-big1.jpg = File

Describe: Fioor pian of ths fialise]|

¢ Name: Enter a name for your e-map of your choice.

¢ Picture: Click File and then select a .png, .bmp, or .jpg image on your computer to
use as the e-map.

¢ Describe (optional): Enter a text description of the e-map.

4. Click Save.
5. Click Edit to edit the e-map.
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6. Click and drag cameras from the device list to place them on the map.

j S S

6

To open cameras from the e-map:

1. Click View.
2. Double-click cameras on the map to open live video.

8.10 Devices
The Devices menu is where you can manage systems connected to the client software.

To access the Devices menu:

e Click and then click .
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Devices overview:

1. Devices Found: Shows systems that are connected to the same network as the com-
puter where the client is installed. Once you connect to the system, it moves to the bot-
tom of the screen.

2. Search: Refresh the list of systems connected to the network.

3. Add: Add checked systems to the client software.

4. Device list: Shows a list of systems connected to the client software, and shows which
systems are online.

5. Add Device: Add a remote system using a Device ID or IP/DDNS address.

6. Delete: Delete the selected system.

7. Import: Import a list of systems from a saved .xml file.

8. Export: Export a list of currently connected systems to an .xml file. This is useful if you

need to re-install the software or if you want to open the same list of systems on a dif-
ferent computer.

9. Delete: Delete system.

10. Manual connect/disconnect: Manually connect/disconnect the system.

11. Edit: Edit the connection details for the system.

8.11 Device Config
The Device Config menu allows you to remotely configure settings for connected systems.

To access the Device Config menu:

¢ Click and then click =2

* Click on a system in the device list to see the settings available for that system and then
configure settings as needed.
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Note
The settings available depend on the model of system you have.

8.12 Alarm CFG

The Alarm CFG menu allows you to configure alarms for the client software. The client
software will alert you by popping up live video and playing sound alerts.

Note
Alarm upload must be enabled on the system in order for it to send the alarm to the client software.

To create alarms:

1. Click - and then click #ee

2. Click Add to create a new alarm.
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3. Inthe Alarm sources menu, you set up the parameters that trigger the alarm.

¢ Under Alarm Type, select the alarm type that will trigger an alarm. For example,
you can select Motion Detect for the alarm to be triggered by motion.

» Select the systems or channels you would like to trigger an alarm. Continuing the
example, if CAM 1 is selected, the alarm will be triggered if there is motion on CAM
1.

* Click Next.
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4. Inthe Alarm link menu, you set up the responses to alarms. Select the channels that
will pop up or alarm out devices (not included; not all systems support alarm out devi-
ces) that will be triggered by an alarm.

For each channel selected, configure the following:

¢ Video: Pop up a window with live video from the selected channel, like the one
below.

¢ Record: Record video from the selected channel.

Note
PC Users: You may need to run the client software as admin to record.

* Preset: If you select a PTZ camera, you can select the preset that will be activated
when an alarm occurs.

* Stay Time: Enter how many seconds the video window will stay open or record
when an alarm occurs.

5. Click Next.
6. In the Period window, configure times the alarm will be activated.

7. Click Confirm to save the alarm.
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To manage alarms:

Export: Export current list of alarms as an xml file.
Import: Import list of alarms.

Delete: Delete selected alarm.

Add: Add new alarm.

Alarms.

On/off: Click to enable/disable alarm.

Delete: Click to delete alarm.

Edit: Click to edit alarm settings.

N R~LN =

8.13 Tour & Task

The Tour & Task menu is where you can set up custom views for the system. You can also
set up tours, which sets the client to automatically cycle through views.

To start a tour:
¢ Click - in Live View to start a tour. The live view will automatically cycle through all
views you have set up in the Tour & Task menu. Click again to stop the tour.

To add views:

1. Click and then click H8,

2. Click + to create a new view.
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3. Under Name, enter a name for your view.

4. Under Stay Time, enter the number of seconds the view will be shown before the cli-
ent switches to the next view.

5. Select the split-screen mode you would like to use for the view and then click and drag
channels to the empty grid areas to select channels to be shown in the view.

SEEEDDODOd =

6. Click Save to save the view. Or click Add More to save the view and create another
view.

8.14 Account

The Account menu is where you can set up user accounts and passwords for the client
software. To simplify management, you can group user accounts according to role. A role
determines the permissions an individual user account can have.

To access the account menu:
e Click and then click n

8.14.1 Managing User Accounts

By default, the client software includes an admin account that has full access to all fea-
tures of the software and all connected systems. You can add user accounts with custom-
ized levels of access.

Note
The admin account cannot be deleted. The default user name for the admin account is admin and the
default password is admin.
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To create a user account:
1. Click Add.

Password Confirm Password

Remarks

UserRights o Channel List

Cancel

e User Name: Enter a user name for the account.

* Role: Select the role for the user account. By default, the user account gains all the
permissions of the role selected, but you can deactivate permissions as needed.

¢ Password/Confirm Password: Enter the password for the user account.

* Remarks (Optional): Enter a text description of the user account.

* User Rights: Check the permissions that will apply to the user account. If you click
on LiveView, Playback, and PTZ, you can select which channels the user account
can access in the Channel List section.

3. Click Save to create the account.

To switch between user accounts:

* Click B

To modify a user account:

Note
Admin accounts with Account Setup permissions can change account passwords. A user cannot change
his own password.

* Click . next to the user account you would like to modify. Edit the user account de-
tails and click Save.
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To delete a user account:
1. Click - next to the user account you would like to delete. Click OK to confirm.

8.14.2 Managing Roles

Roles make it easier to manage user accounts by determining the permissions an individu-
al user account can have. By default, a new user account is given all the permissions of
the role they are assigned to.

To create a role:

1. Click the Role tab.
2. Click Add.

3. Configure the following settings for the role:

Role Name [uUsers|

Remarks

Channel List

¢ Role Name: Enter a name for the role.

¢ Remarks (Optional): Enter a text description of the role.

* Role Rights: Check the permissions that will apply to user accounts assigned this
role. If you click on LiveView, Playback, and PTZ, you can select which channels
may be accessed in the Channel List section.

4. Click Save.

To modify a role:

* Click . next to the role you would like to modify. Edit the role details and click Save.
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To delete a user account:
1. Click - next to the role you would like to delete. Click OK to confirm.

8.15 General
The General menu is where you can configure application settings for the client software.

To access the General menu:

e Click and then click E=8

8.15.1 Basic

The Basic menu contains general settings for the client software.

The Basic menu contains the following settings:

* Log Saved Time: Select the number of days you would like the client to save log
entries.

¢ Instant Playback Time: Select the number of minutes the system will go back when
you start an instant playback.

* Network Capability: Select the speed of your computer’s network connection.

* Resume Live View State: Check for the client to resume live view when it starts up.
The live view will open to the last view that you had open.

* Auto login application: Check for the client to automatically login when it starts up
without entering a user name or password.

¢ Auto Login Windows: Not supported.

¢ Language: Select the language for the client software.

* Sync Time: Check to have the client software sync time with your computer’s system
time. Select the time the software will sync the time. Click Sync Now to manually sync
the time.

¢ Time Format: Select 12-Hour or 24-Hour time format. You must close the client and
restart it to apply this setting.

Note
Click Save to save setting changes.

8.15.2 File

The File menu allows you to select the folders where the client software will save down-
loaded video files and snapshots.
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The File menu contains the following options:

* Snapshot Path: Click Browse to select the default folder to save snapshots.

* Record Path: Click Browse to select the default folder to save video recordings.

¢ Config Path: Click Browse to select the folder where the client will save software con-
fig files.

Note
Click Save to save setting changes.

PC Users: You may need to run the client software as admin to save files to enable snapshot or video
recording.

8.15.3 Alarm Prompt

The Alarm Prompt menu allows you to configure audio alerts. The client will play audio
alerts when events occur. You can replace the default sounds with any .wav file.

Note
You must configure alarms in the Alarm CFG menu before the client will play alarm sounds.

The Alarm Prompt menu has the following options:

¢ Open Audio: Check to enable audio alerts.

¢ Loop: Check to repeat audio alerts until acknowledged.

e Camera Masking: Select or preview the sound that will play for camera masking
alarms.

¢ Motion Detect: Select or preview the sound that will play for motion detection.
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¢ Video Loss: Select or preview the sound that will play for video loss alarms.

¢ Disk Full: Select or preview the sound that will play for disk full alarms.

e Disk Error: Select or preview the sound that will play for disk errors.

e External: Select or preview the sound that will play for external alarms (triggered by
sensor devices, which may not be supported on all systems).

e E-map flashes when alarm occurs: If the camera has alarms enabled and is added

to an e-map, a = appears on the e-map when an event occurs.

Note
Click Save to save changes.

8.15.4 \Version

The Version menu shows you which version of the client software you are using. It is rec-
ommended to always run the latest version of the software from www.flirsecurity.com/pro.

FLIR Cloud Client
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FLIR Cloud is a free mobile app that is compatible with iPhone, iPad and Android devices.

Platform Supported Versions App Name Get App From
and Devices

iOS iPhone/iPad FLIR Cloud™ Apple App Store

Android Android FLIR Cloud™ Google Play Store

See www.flirsecurity.com/pro for the latest list of supported apps and devices.

9.1 iPhone

FLIR Cloud is an iPhone app that allows you to remotely view your IP camera.

9.1.1 Prerequisites

e Port 80 and 35000 (or your HTTP and Client Ports, if you have changed them) must be
port forwarded on your router to your camera’s IP address.

* You must create a DDNS account, and have the DDNS settings configured in your IP
camera.

¢ The IP camera must have Internet access.

¢ You must have a DDNS address to log in remotely.

¢ AniTunes account.

Note

You will need to create an iTunes account before you can download the app. An iTunes store account
requires a valid credit card number. The app is free of charge.

9.1.2 Connecting to your IP camera on an iPhone
1. Download FLIR Cloud™ for free from the App Store.

2. Tap on the FLIR Cloud™ icon (COB) to start the app.

Note

The first time it opens, the app will ask for permission to send push notifications and to access Pho-
tos. It will only send natifications if you enable motion-activated push notifications in the Push Config
menu. It needs access to Photos to save snapshots and video clips to the local storage on your mo-
bile device.

Tap then @
@ Live Preview

w

e—te—-—0I
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4. Configure the following:

)
[ol=]
Scan QR Code =g, 3
(1 ’ Register Mode: IP/Domain >
=
Name: HD System
@ Address: tomsmith.myddns-flir.com
2
Client Port: 35000
@ Username: admin
s
Password:  seees

Live Preview: Sub >

Playback: Sub >

Start Live Preview

4.1. Register Mode: Select IP/Domain.

4.2. Name: Choose a name for your IP camera of your choice.

4.3. Address: Enter the IP address or DDNS address of your IP camera. (e.g. tom-
smith.myddns-flir.com).

4.4. Client Port: Enter the Client Port (default: 35000).

4.5. Username: Enter the IP camera’s User Name (default: admin).

4.6. Password: Enter the IP camera’s Password (default: admin).

5. Tap Start Live Preview.
6. The app opens in Live View and streams video from your camera.

9.1.3 Live View Interface

You can use FLIR Cloud™ in portrait and landscape mode.

Live View Overview

@—@ Live Preview

1. Menu: Tap to bring up the Menu.
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o
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Display Area: Double-tap to open a channel in full screen. Swipe left or right to select
a different page of channels.

Pages: Shows the number of pages available and highlights the currently selected
page.

Split: Select the split-screen layout.

Snapshot: Tap to take a snapshot from the currently selected channel.

Control Bar: Contains the following options. Swipe left or right to access more options.

58466 b o

Quick Playback: Tap to start/stop quick playback.
6.2. PTZ Controls: Open/close PTZ controls. PTZ camera required.
6.3. Streaming Quality: Open/close streaming quality panel.
6.4. Not supported.
6.5. Not supported.
6.6. Not supported.
6.7. Not supported.
6.8. Color Settings: Tap to access color controls for the currently selected camera.

Manual record: Tap to start/stop manual recording.
Connect/disconnect all: Connect to/disconnect from all previously added cameras.
Access Favorites.

. Device List: Tap to open a list of devices. You can use the Device List to open multiple

systems or cameras at once.

9.1.4 Controlling PTZ Cameras

If you have PTZ cameras, you can control them from the app.

To control PTZ cameras:

1.

2.

Tap the display area the PTZ camera is connected to.

Tap “ 1o open PTZ controls.
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PTZ Controls

@ Live Preview

1. Live Display: Swipe to move the camera. Pinch to zoom in/out.

2. lIris: Tap to show iris controls.

3. Focus: Tap to show focus controls.

4. Zoom: Tap to show zoom controls.

5. PTZ/EPTZ: Tap to switch between PTZ and EPTZ mode. Use PTZ mode to control
PTZ cameras. Use EPTZ mode to activate digital zoom mode on non-PTZ cameras.

6. Goto preset: Tap to access preset controls. Then use the sliders to select a preset
and then tap the checkmark to goto the preset.

Note
You must set presets for the camera using the system’s local menus before you can use this feature.

9.1.5 Viewing Snapshots and Videos with Local Files
If you have saved snapshots or videos using the app, you may open them with Local Files.

To access Local Files:

e Tap @ to access the Menu, and then tap Local Files.
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Local Files Overview

D—6 o—@)

20140401 152431

Menu: Return to Menu.

Files: Tap to open files.

File Type: Tap the options to select video files or snapshots.
Options: Tap to delete or export files to your device’s local storage.

EalE

Note

Exported snapshots and video files are saved to the Photos app. Video files are saved to MP4
format.

9.1.6 Using Playback Mode on iPhone

You can access recorded video on your system using your iPhone.

Note
You must enable Sub Stream Recording to use playback mode on mobile devices.

To use Playback Mode:

1. Tap @ to access the Menu, and then tap Video Playback.

2. Tap + and select a channel to playback.

© EHN )

CECHONONCNC

(O] B < ¢

00:00:00 00:00:00

3. Select the date then the start and end times to playback.
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4. Use the on-screen controls to control playback.

Playback Controls

Display Area: Double-tap to open in full-screen.

Play/pause.

Time Bar: Tap inside the bar to fast forward or rewind.

Previous: Select previous video file.

Next: Select next video file.

Snapshot: Tap to take a snapshot from the selected camera.

Stop All: Stop playback on all channels.

Not supported.

Manual Record: Tap to start/stop recording to your mobile device’s local storage.
Fast.

Slow.

Time Range: Tap to change the range of time shown in the time bar.
Next frame.

9.1.7 Enabling Push Notifications

You can have the app send push notifications to the notifications area on your device when
one of your cameras detects motion. Once you have received a push notification, you can
select it to open live video or a snapshot attachment from the camera that detected motion.
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Note

Your cameras must have motion detection activated to receive push notifications.

To enable Push Notifications:

1. Tap @ to access the Menu, and then tap Push Config.

2. Tap the system you would like to configure.

@ Push Config

CEZ HD System
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3. Tap Motion Detect and then check each channel you would like to receive push notifi-
cations from.

@ HD System @

Period 365 Day

Pushtype | Video

¥ Motion Detect

@) Front
®©) cam2
@®) cams
@®) cama
@®) caus
@®) came
® cam7

(El\ CAM 8

J000000#80

4. Tap @ to save changes. You will now receive a notification when one of the selected
cameras detect motion.

9.1.8 Using the Event List

The Event List menu shows a list of events that were sent to your device via push
notifications.

Note
You must configure push notifications before you can use the Event List.

To access the Event List:

e Tap @ to access the Menu, and then tap Event List.

Event List Overview

®ee00 Bell LTE 3:23 PM T % 49% m )

@ Event List @—@

®_ 04-07 15:23:25  Video motion

04-07 15:22:48  Video motion

1. Events: Shows the details of each motion detection event. Tap the event to view the video or snapshot.
2. Delete All: Tap to delete all events in the Event List.

Note
To delete a single event, swipe it to the left and then tap Delete.

eeec0 Bell LTE 3:24 PM

@ Event List

04-07 15:23:25  Video motion

07 15:22:A$ Video motion
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9.1.9 Using Favorites

Favorites allows you to select a group of cameras as a favorite. You can then quickly bring

up the group of cameras in Live View without having to individually select each camera.

To use Favorites:

1. Tap @ to access the Menu, and then tap Favorites.

2. Tap a group to configure an existing group.
Note

Tap to create a new group and then enter a name for the new group.

3. To add cameras to the group, tap @

4. Select the cameras you would like to add to the group. Tap @ to save changes.

@ Favorites @

© HDsystem

@® Front (*]
@® cam2 (]
® cam3

@® cama

@ cavs

® cams

® cam7

@® cavs

Note

To delete cameras that have been added to the group, select the group in the group list. Then, press

and hold to delete cameras from the group.
To open Favorites in Live View:

1. Tap @ to access the Menu, and then tap Live Preview.
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2. Tap * , and then tap } to open the group.

S S S)

Live Preview Live Preview

®

Group

B ®H OB
@i+ ¢ ¥ B o

9.1.10 Using the E-Map

E-Map allows you to place cameras over a stillimage. For example, you can use the E-
Map to create a virtual map of your cameras over a floor plan of your home or business.

To add an E-Map:
1. Tap @ to access the Menu, and then tap E-Map.
2. Tap @

@ E-Map @

3. Select a.jpg image on your mobile device.
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4. Press and select a camera. Drag the camera on the screen to place it on the map.

Repeat to add additional cameras.

@ Unnamed

e
L

5. Click . Choose a name for your E-Map and then tap OK.

To open cameras from an E-Map:

1. Tap in Live View.

2. Select the E-Map in the Device List.

@ Device List @
E-Map

° Home >
Device

° HD System D

Start Live Preview(0)
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3. Tap the camera or cameras to select and then tap Start Live Preview to open the
cameras.

Start Live Preview

9.1.11 Device Manager
You can use Device List to add, delete, or edit your systems.

To access Device Manager:

e Tap @ to access the Menu, and then tap Device Manager.
To edit a system:

£

1. Tap the system in Device Manager. Tap = .

@ Device Manager @

CE=  HD System

7 B A 6| T

2. Edit the connection details as needed.
3. Tap Start Live Preview to save changes and connect to the system.

To delete a system:

1. Tap the system you would like to delete.
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2. Tap (0 . Tap OK to confirm.
@ Device Manager @

CE= HD System

7 BlA 6 @

9.2 iPad

FLIR Cloud™ is an iPad app that allows you to remotely view your system.

9.2.1 Prerequisites

e Port 80 and 35000 (or your HTTP and Client Ports, if you have changed them) must be
port forwarded on your router to your camera’s IP address.

* You must create a DDNS account, and have the DDNS settings configured in your IP
camera.

¢ The IP camera must have Internet access.

* You must have a DDNS address to log in remotely.

* AniTunes account.

Note
You will need to create an iTunes account before you can download the app. An iTunes store account
requires a valid credit card number. The app is free of charge.

9.2.2 Connecting to your IP Camera on an iPad

1. Install FLIR Cloud™ for free from the App Store.

N
2. Tap onthe FLIR Cloud™ icon (CVB) to start the app.

Note

The first time it opens, the app will ask for permission to send push notifications and to access Pho-

tos. It will only send natifications if you enable motion-activated push notifications in the Push Config
menu. It needs access to Photos to save snapshots and video flips to the local storage on your mo-

bile device.

3. Tap then .

4. Tap Device Manager.
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5. Tap Add.

Configuration

6. Configure the following:

EXAMPLE

New Device

o Register Mode:  |P/Domain
Neme: HD_System

e Adcress:  tomsmith.lorex...

0 Client Port: 35000

UserName:  admin
Password:  eeese

hannel amount: |

Start Live Preview

6.1. Register Mode: Select IP/Domain.
6.2. Name: Choose a name for your IP camera of your choice.

Device Manager

6.3. Address: Enter the IP address or DDNS address of your IP camera. (e.g. tom-
smith.myddns-flir.com).

6.4. Client Port: Enter the Client Port (default: 35000).
6.5. User Name: Enter the IP camera’s User Name (default: admin).
6.6. Password: Enter the IP camera’s Password (default: admin)

6.7. Channel Amount: Enter 1.

7. Tap Start Live Preview.

8. The app opens in Live View and streams video from all connected cameras.

9.2.3 Live View Interface

You can use FLIR Cloud™ in landscape or portrait mode.
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Live View Overview

4GB0 CT @@ B

Display area: Double-tap to open camera in full screen.

Favorites: Slide to select favorites.

Disconnect all: Disconnect all cameras.

Add to favorites: Add the current view to favorites.

Shapshot: Tap to take a snapshot from the currently selected channel.

o~ owbd =

Note
You can view or share snapshots using the Photos app.

Change display view.

Not supported.

Manual record: Tap to start/stop manual recording from this channel.
. Not supported.

0. Open menus.

1. Select different camera.

T3NS

9.2.4 Controlling PTZ Cameras
If you have PTZ cameras, you can control them using the app.
To control PTZ cameras:

1. In Live View, tap the window the PTZ camera is connected to.
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2. Slide the middle controls to the right to access PTZ controls.

. TAETAR 04 02453 1IPM Fri

PTZ Controls

-T2

Live display: Swipe to move the camera. Pinch to zoom in/out.

Direction buttons: Tap to move the camera.

Zoom: Tap to zoom the camera in/out.

Focus: Tap +/- to adjust the focus.

Iris: Tap +/- to adjust the iris.

PTZ/EPTZ: Tap to switch between PTZ and EPTZ mode. Use PTZ mode to control
PTZ cameras. Use EPTZ mode to activate digital zoom mode on non-PTZ cameras.
7. Goto preset: Tap to goto a camera preset.

1.
2.
3.
4.
5.
6.

Note
You must set presets for the camera using the system’s local menus before you can use this feature.

9.2.5 Using Playback Mode on iPad

You can access recorded video on your system using your iPad.
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Note
You must enable Substream Recording to use playback mode on mobile devices.

To use Playback Mode:

1. From Live View tap E then .

2. In Portrait Mode: Tap +, select the start time and end time for your search, and select
the camera you would like to playback.
OR

In Landscape Mode: Select the start time and end time for your search, and drag the
camera you would like to playback to the display area.

B @ 20140005 1437200

© 2014-04-0315:37:00

3. Use the playback controls.
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Playback Controls

Display area: Double-tap to open camera in full screen.
Play/pause.
Previous file.
Disconnect: Disconnect the currently selected camera.
Not supported.
Snapshot: Tap to take a snapshot from the currently selected camera.
Change display view.
Menu.
Next file.
0. Time range: Tap to change the range of time shown in the time bar.
1. Time Bar: Tap inside the bar to fast forward or rewind.

23O NOO AL~

Note
Playback controls are only shown in portrait mode.

9.2.6 Using Local File to View Manual Recordings
You can view manual recordings saved to your mobile device using the Local File menu.

To view manual recordings:

1. From live view, tap H then .
2. Tap Local File.
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3. Tap avideo file to openiit.

Configuration Local File

y o
Device Manager r Lol |
i
i <~
L

Channel Config

Push Config

~ 20140403161439.dav

Local File

Relay out Config

Favorites

Local Config

Help

To delete videos:
1. Tap Edit.

2. Select the videos you would like to delete and tap .

9.2.7 Enabling Push Notifications

You can have the app send push notifications to the notifications area on your device when
one of your cameras detects motion. Once you have received a push notification, you can
select it to open video or an image from the camera that detected motion.
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@ FLIR Cloud

FLIR Cloud

Note
Your cameras must have motion detection activated to receive push notifications.

To enable Push Notifications:

1. From live view, tap ﬁ then .

2. Tap Push Config.
3. Tap the slider for the system you would like to configure.

Configuration Push Config

Device Manager BT HD_System
Channel Config

Push Config

Local File

Relay out Config

Favorites

Local Config

Help
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4. Tap Motion Detect then check each channel you would like to receive push notifica-
tions from.

Configuration HD_System

Device Manager Period: m Days
Ll Playback [ED)

v Video motion (@)

Channel Config

Push Config
Front

Local File CAM 2

Relay out Config CAM 3
CAM 4
Favorites
CAM 5
Local Config

CAM 6

(0]
]
||
A
<
®

Help CAM 7
CAM B

> Video Blind

5. Under Type, select Playback to attach a video file with each push notification. Or, se-
lect Picture to attach a still image of the camera that detected motion.

6. Tap OK to save change. Whenever the selected cameras detect motion, you will re-
ceive a notification.

9.2.8 Using the Event List

The Event List menu shows a list of events that were sent to your device via push
notifications.

Note
You must configure push notifications before you can use the Event List.

To access the Event List:

1. From live view, tap then .
Alarm event

03-25 14:43:29 Motion Detect Channel 3 nvrlan
03-25 14:43:19 Motion Detect Channel 3 nvrlan
03-21 16:04:42 Motion Detect Channel 1 nvr
03-21 16:04:16 Motion Detect Channel 1  nvr
03-21 16:03:59 Motion Detect Channel 1 nvr
03-21 16:02:08 Motion Detect Channel 1 nvr
03-21 16:01:29 Motion Detect Channel1 nvr

03-21 15:59:06 Motion Detect Channel 1 nvr

03-21 15:58:23 Motion Detect Channel 1 nvr
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9.2.9 Using Favorites

Favorites allows you to select a group of cameras as a favorite. You can then quickly bring
up the group of cameras in Live View without having to individually select each camera.

To create favorites:

A

1. InLive View, tap . to save the cameras that are currently open as a favorite.
2. Enter a name for the favorite and tap OK.

To open favorites in Live View:

¢ In Live View, slide the dial to cycle through favorites.

To edit favorites:

1. From live view, tap ﬁ then .

2. Tap Favorites.
3. Tap the favorite you would like to edit.

4. Tap Edit.
5. Select the cameras you would like to include in the favorite and then tap Save.
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9.2.10 Using the E-Map

E-Map allows you to place cameras over a still image. For example, you can use the E-
Map to create a virtual map of your cameras over a floor plan of your home or business.

To add an E-Map:

1. From live view, tap &

2. Tap Add.

3. Select a .jpg image file on your mobile device.

#L.X400038; r. 1.0/18537/18537; en-US

111



Smartphone and Tablet Apps

4. To edit the E-map:

.

_J

A

IM—_I [

N

T
N

©

L

=

b & s

4.1. Select Image: Select different image file to use for your E-Map.
4.2. Add Camera: Tap + to select cameras to add to your E-Map. Then drag the

camera to place it on the E-Map.
4.3. Delete E-Map.

5. When you are finished editing the E-Map, tap Save and enter a name for the E-Map to

save changes.

To open cameras using the E-Map:

1. Inlive view, tap + on an empty display window and select the E-Map.
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2. Tap a camera from the E-map to open.

9.2.11 Using the Device Manager
Device Manager allows you to manage your systems.

To access Device Manager:

1. From live view, tap ﬁ then .

2. Tap Device Manager.
To delete a system:

1. Tap the system to select it.

2. Tap @ Tap Yes to confirm.

Configuration Device Manager

Device Manager
Relay out Config

Favorites

Local Config

Help

To modify a system:

1. Tap a system to select.
2. Tap the system again to open the edit screen.
3. Update the connection details as needed and then tap Save.

9.3 Android

FLIR Cloud is an Android app that allows you to remotely view your IP camera.

9.3.1 Prerequisites

* Port 80 and 35000 (or your HTTP and Client Ports, if you have changed them) must be
port forwarded on your router to your camera’s IP address.

#L.X400038; r. 1.0/18537/18537; en-US 113



Smartphone and Tablet Apps

* You must create a DDNS account, and have the DDNS settings configured in your IP
camera.

e The IP camera must have Internet access.

* You must have a DDNS address to log in remotely.

¢ A Google Play account.

9.3.2 Connecting to your IP camera on Android
1. Download FLIR Cloud™ for free from the App Store.

2. Tap onthe FLIR Cloud™ icon (COB) to start the app.

3. Tap then @

@ Live Preview I@ Beviee s ) . I

4. Configure the following:

)
Scan QR Code Eg >
Al ety
@ Register Mode: IP/Domain >
¥
@ Name: HD System
¥
@ Address: tomsmith.myddns-flir.com
*
@ Client Port: 35000
@ Username: admin
@ s

Live Preview: Sub >

Playback: Sub >

Start Live Preview

4.1. Register Mode: Select IP/Domain.

4.2. Name: Choose a name for your IP camera of your choice.

4.3. Address: Enter the IP address or DDNS address of your IP camera. (e.g. tom-
smith.myddns-flir.com).

4.4. Client Port: Enter the Client Port (default: 35000).

4.5. Username: Enter the IP camera’s User Name (default: admin).

4.6. Password: Enter the IP camera’s Password (default: admin).

5. Tap Start Live Preview.
6. The app opens in Live View and streams video from your cameras.

9.3.3 Live View Interface

You can use FLIR Cloud™ in portrait and landscape mode.

#L.X400038; r. 1.0/18537/18537; en-US 114



Smartphone and Tablet Apps

Live View Overview

—_

oo

S©oN

Live Preview

Menu: Tap to bring up the Menu.

Display Area: Double-tap to open a channel in full screen. Swipe left or right to select
a different page of channels.

Pages: Shows the number of pages available and highlights the currently selected
page.

Split: Select the split-screen layout.

Snapshot: Tap to take a snapshot from the currently selected channel.

Control Bar: Contains the following options. Swipe left or right to access more options.

5686666

Quick Playback: Tap to start/stop quick playback.
6.2. PTZ Controls: Open/close PTZ controls. PTZ camera required.
6.3. Streaming Quality: Open/close streaming quality panel.
6.4. Not supported.
6.5. Not supported.
6.6. Not supported.
6.7. Not supported.
6.8. Color Settings: Tap to access color controls for the currently selected camera.

Manual record: Tap to start/stop manual recording.
Connect/disconnect all: Connect to/disconnect from all previously added cameras.
Access Favorites.

. Device List: Tap to open a list of devices. You can use the Device List to open multiple

systems or cameras at once.

9.3.4 Controlling PTZ Cameras

If you have PTZ cameras, you can control them from the app.

To control PTZ cameras:

1.

Tap the display area the PTZ camera is connected to.
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2. Tap o open PTZ controls.

PTZ Controls

@ Live Preview

® & - @ o

Live Display: Swipe to move the camera. Pinch to zoom in/out.

Iris: Tap to show iris controls.

Focus: Tap to show focus controls.

Zoom: Tap to show zoom controls.

PTZ/EPTZ: Tap to switch between PTZ and EPTZ mode. Use PTZ mode to control
PTZ cameras. Use EPTZ mode to activate digital zoom mode on non-PTZ cameras.
Goto preset: Tap to access preset controls. Then use the sliders to select a preset
and then tap the checkmark to goto the preset.

AN

o

Note
You must set presets for the camera using the system’s local menus before you can use this feature.

9.3.5 Viewing Snapshots and Videos with Local Files
If you have saved snapshots or videos using the app, you may open them with Local Files.

To access Local Files:

e Tap @ to access the Menu, and then tap Local Files.
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Local Files Overview

D—6 o—@)

20140401 152431

Menu: Return to Menu.

Files: Tap to open files.

File Type: Tap the options to select video files or snapshots.
Options: Tap to delete or export files to your device’s local storage.

EalE

Note

Exported snapshots and video files are saved to the Photos app. Video files are saved to MP4
format.

9.3.6 Using Playback Mode on iPhone

You can access recorded video on your system using your iPhone.

Note
You must enable Sub Stream Recording to use playback mode on mobile devices.

To use Playback Mode:

1. Tap @ to access the Menu, and then tap Video Playback.

2. Tap + and select a channel to playback.

© EHN )

CECHONONCNC

(O] B < ¢

00:00:00 00:00:00

3. Select the date then the start and end times to playback.
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4. Use the on-screen controls to control playback.

Playback Controls

Display Area: Double-tap to open in full-screen.

Play/pause.

Time Bar: Tap inside the bar to fast forward or rewind.

Previous: Select previous video file.

Next: Select next video file.

Snapshot: Tap to take a snapshot from the selected camera.

Stop All: Stop playback on all channels.

Not supported.

Manual Record: Tap to start/stop recording to your mobile device’s local storage.
Fast.

Slow.

Time Range: Tap to change the range of time shown in the time bar.
Next frame.

9.3.7 Enabling Push Notifications

You can have the app send push notifications to the notifications area on your device when
one of your cameras detects motion. Once you have received a push notification, you can
select it to open live video or a snapshot attachment from the camera that detected motion.
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Note

Your cameras must have motion detection activated to receive push notifications.

To enable Push Notifications:

1. Tap @ to access the Menu, and then tap Push Config.

2. Tap the system you would like to configure.

@ Push Config

CEZ HD System
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3. Tap Motion Detect and then check each channel you would like to receive push notifi-
cations from.

@ HD System @

Period 365 Day

Pushtype | Video

¥ Motion Detect

@) Front
®©) cam2
@®) cams
@®) cama
@®) caus
@®) came
® cam7

(El\ CAM 8

J000000#80

4. Tap @ to save changes. You will now receive a notification when one of the selected
cameras detect motion.

9.3.8 Using the Event List

The Event List menu shows a list of events that were sent to your device via push
notifications.

Note
You must configure push notifications before you can use the Event List.

To access the Event List:

e Tap @ to access the Menu, and then tap Event List.

Event List Overview

®ee00 Bell LTE 3:23 PM T % 49% m )

@ Event List @—@

®_ 04-07 15:23:25  Video motion

04-07 15:22:48  Video motion

1. Events: Shows the details of each motion detection event. Tap the event to view the video or snapshot.
2. Delete All: Tap to delete all events in the Event List.

Note
To delete a single event, swipe it to the left and then tap Delete.

eeec0 Bell LTE 3:24 PM

@ Event List

04-07 15:23:25  Video motion

07 15:22:A$ Video motion
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9.3.9 Using Favorites

Favorites allows you to select a group of cameras as a favorite. You can then quickly bring
up the group of cameras in Live View without having to individually select each camera.

To use Favorites:

1. Tap @ to access the Menu, and then tap Favorites.

2. Tap a group to configure an existing group.
Note

Tap to create a new group and then enter a name for the new group.

3. To add cameras to the group, tap @

4. Select the cameras you would like to add to the group. Tap @ to save changes.

@ Favorites @

© HDsystem

@® Front (*]
@® cam2 (]
® cam3

@® cama

@ cavs

® cams

® cam7

@® cavs

Note

To delete cameras that have been added to the group, select the group in the group list. Then, press
and hold to delete cameras from the group.

To open Favorites in Live View:

1. Tap @ to access the Menu, and then tap Live Preview.
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2. Tap * , and then tap } to open the group.

S S S)

Live Preview Live Preview

®

Group

B ®H OB
@i+ ¢ ¥ B o

9.3.10 Using the E-Map

E-Map allows you to place cameras over a stillimage. For example, you can use the E-
Map to create a virtual map of your cameras over a floor plan of your home or business.

To add an E-Map:
1. Tap @ to access the Menu, and then tap E-Map.
2. Tap @

@ E-Map @

3. Select a.jpg image on your mobile device.
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4. Press and select a camera. Drag the camera on the screen to place it on the map.

Repeat to add additional cameras.

@ Unnamed

e
L

5. Click . Choose a name for your E-Map and then tap OK.

To open cameras from an E-Map:

1. Tap in Live View.

2. Select the E-Map in the Device List.

@ Device List @
E-Map

° Home >
Device

° HD System D

Start Live Preview(0)

#L.X400038; r. 1.0/18537/18537; en-US

123



Smartphone and Tablet Apps

3. Tap the camera or cameras to select and then tap Start Live Preview to open the
cameras.

Start Live Preview

9.3.11 Device Manager
You can use Device List to add, delete, or edit your systems.

To access Device Manager:

e Tap @ to access the Menu, and then tap Device Manager.
To edit a system:

£

1. Tap the system in Device Manager. Tap = .

@ Device Manager @

CE=  HD System

7 B A 6| T

2. Edit the connection details as needed.
3. Tap Start Live Preview to save changes and connect to the system.

To delete a system:

1. Tap the system you would like to delete.
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2. Tap (0 . Tap OK to confirm.
@ Device Manager @

= HD System

7 BlA 6 @
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Appendix A — Camera
Conditions (Select models only)

The Conditions menu allows you to configure the image sensor settings for the camera.
As you make adjustments, the effects will be shown in the video display.

Note

This section provides instructions for using the Camera Conditions menu, which is used only on certain
camera models to configure image sensor settings. For instructions on configuring standard image sen-

sor settings, see 5.1.1 Settings, page 14.

Camera Conditions

Network
ard

Event

Storage

Config file . Normal -

Exposure
NR
Day&Night

Focus

System Zoom

Information Sharpness
Picture

Default

10.1 Image Sensor Setting

Select the camera configuration profile. Configure camera settings within each profile to
easily switch back and forth between different condition profiles.

To configure the image sensor settings:

1. Under Config File, select Normal, Day or Night. You can configure the image sensor
settings differently for each profile, allowing you to quickly apply different settings if
required.

* Normal: Set based on normal camera conditions and environment.
* Day: Set to optimize for daytime surveillance.
* Night: Set to optimize for nighttime surveillance.

2.

10.2 White Balance Setting

Set the white balance mode for the camera.

Camera Conditions Profile Management

Config file . Normal -

Network Exposure

PTZ MR
Event Day&Night
Storage Focus

Zoom

System

Information Sharpness
Picture

Default

To configure the white balance settings:

1. Click WB to enter the white balance submenu.
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2. Under WB Mode, select one of the following:

¢ Auto: The camera adjusts white balance automatically.

e ATW: The camera adjusts white balance automatically for various color
temperatures.

¢ Indoor: Recommended for most indoor installations.

¢ Outdoor: Recommended for outdoor installations.

¢ Outdoor Auto: Recommended for outdoor installations — white balance is ad-
justed automatically for outdoor lighting conditions.

¢ Sodium Light: Recommended for environments with natural lighting.

¢ Sodium Light Auto: Recommended for environments with natural lighting — white
balance is adjusted automatically for natural lighting conditions.

¢ Manual: This mode allows you to configure the R GAIN (red) and B GAIN (blue)
values to achieve proper white balance.

P wo N
» Exposure Red El_ U‘_ E|50
b b Biie [=]- & 50

» Day&Night
¢ Focus

v Zoom

» Sharpness
v Picture

» Default

10.3 Exposure Setting

Select the camera’s exposure mode — different exposure modes allow you to configure
different sets of attributes.

Config File | Normal -

v w8 Exposure  Auto -
Anti-ficker (@) Qutdoor (=) Anti-fiicker 50HZ
i ) Anti-flicker 60HZ
’ A

DRENIGNt | oy ssure Comp (=] ! )
» Focus 0 o

Slow Expo [= AL
N =) (]
f » @

» Sharpness Max Auto Gain ) Low ) Middle @ High
* Picture Slow Shutter [7]
b Default Auto SS Limit 1730 v

AERecovery  15m =

WOR  Close -
HLC Close -

BLC Close -

To select an exposure mode:

1. Click Exposure to enter the exposure setting submenu.
2. Under Exposure, select one of the following exposure modes:

¢ Auto: The settings for gain, iris, and shutter are determined automatically by the
software.

¢ Aperture Priority: Configure iris settings — gain and shutter settings are deter-
mined automatically by the software.

* Shutter Priority: Configure shutter settings — gain and iris settings are determined
automatically by the software.

* Manual: Advanced users only — this mode requires you to configure the settings
for gain, iris, and shutter to achieve proper exposure.
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To configure exposure mode:

1.

11.

Under Anti-flicker, choose from one of the following:

e Outdoor: The system will use the exposure mode to adjust for lighting.

¢ Anti—flicker 50Hz: The system will compensate for lighting using 50Hz AC power (i.
e. for Europe).

e Anti-flicker 60Hz: The system will compensate for lighting using 60Hz AC power (i.
e. for North America).

Note

Anti-flicker is only required if experiencing color rolling while the camera is connected to AC power. If
your camera model is connected to DC power or to an NVR for PoE use, it is recommended to set
this item to Outdoor.

(Aperture priority mode only) Under Iris, click + / - or use the slider to adjust the iris.
Setting the iris manually determines how much light comes through the lens.

(Shutter priority mode only) Under Shutter, click + / - or use the slider to adjust the
shutter speed. Setting the shutter speed manually determines how long the camera
shutter remains open when capturing an image.

(Manual exposure mode only) Under Gain Level, click + / - or use the slider to set a
gain value. Setting the gain manually allows you to artificially create a brighter or darker
image.

Under Exposure Comp, click + / - or use the slider to set an exposure compensation
value. You can use exposure compensation with automatic exposure to brighten or
darken an image to your preference.

Under Slow Expo, click + / - or use the slider to set a slow exposure value. Slow expo-
sure ensures stable video in environments with greatly varying brightness. It is recom-
mended to use a higher setting for dark environments.

Under Max Auto Gain, choose from Low, Middle, or High. This setting determines
the high limit for the camera’s automatic gain control.

Check Slow Shutter to enable slow shutter. Slow shutter is used to allow extra light in-
to the camera thereby providing brighter images in low light conditions.

Under Auto SS Limit, choose a slow shutter limit (1/1 - 1/30).

.Under AE Recovery, select an auto exposure recovery time. Changing the camera’s

iris setting through the NVR takes priority over the exposure settings in the web inter-
face. Auto Exposure Recovery resets the camera’s iris to the setting specified in the
web interface after a period of time.

Under WDR, select Open or Close to enable / disable wide dynamic range (WDR).
Turning WDR on fixes harsh contrast between bright and dark sections of the camera
image.

Example image for WDR setting
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12. Under HLC, select High, Low or Close to enable / disable high light compensation
(HLC). Turning HLC on darkens extremely bright spots of the camera images to ensure
a clear camera image.

HLC OFF

Example image for HLC setting

13. Under BLC, select Open or Close to enable / disable back light compensation (BLC).
Turning BLC on fixes harsh contrast between bright and dark sections of the camera
image in backlit conditions.

Example image for BLC setting

Note

You can only configure one of the following features: WDR, HLC, BLC. If you attempt to configure 2
of these settings, the first one you configured will automatically be set to Close.

10.4 Noise Reduction Setting

Set the camera’s noise reduction levels — you can set 2 types of noise reduction: 2D tem-
poral noise reduction (2D NR ) and 3D spatial noise reduction (3D NR). The higher the val-
ue, the greater the noise reduction.
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ConfigFile  Mormal X
» we 2DNR V]
S+ Exposure Grade E|—D (EE
AR 7

yw * Day&Night
} L Grade E_O_.. 3
Focus
Zoom

»

3

» Sharpness
» Picture

3

Default

2D noise reduction helps to limit the appearance of noise (graininess in the camera im-
age) around stationary objects. 3D noise reduction accomplishes the same process for
moving objects as well, providing clearer images in low light conditions. Removing noise

from the camera image reduces your recording file size and makes videos clearer and
more detailed.

Example image for 3D NR setting

To configure the noise reduction settings:

1. Click NR to enter the noise reduction setting submenu.

2. Check 2D NR to enable 2D temporal noise reduction, then click + / - or use the slider
under Grade to set the noise reduction value. The higher the value, the greater the
noise reduction.

3. Check 3D NR to enable 3D spatial noise reduction, then click + / - or use the slider
under Grade to set the noise reduction value. The higher the value, the greater the
noise reduction.

10.5 Day/ Night Setting

Configure how the camera switches between day / night modes.
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Config File | Normal -

-
-

r WB Type @ Electron =) Mechanism
=+ Exposure

b NR

L]
r Sensitivity EI 5
==

Day&hlight  Auto -

» Focus
gtll * zoom
¥ Sharpness
b Piclure
¥ Default

To configure day / night settings:

—_

Click Day / Night to enter the day / night submenu..
Under Type, select how the camera switches between day and night modes:

Electron: Day / night switch-over is determined by camera software. This is recom-
mended if the camera switches its viewing mode at around the same time every day
(for example, sunset or sunrise in an outdoor location).

Mechanism: Day / night switch-over is determined by a light filter. This is recom-
mended if the camera is in a location with fluctuating light conditions (for example,
indoors with lights turning on and off throughout the day).

Under Day & Night, select one of the following options:

Auto: The camera switches between day and night mode automatically with chang-
ing light conditions (recommended).

Color: The camera remains in full color. This setting is not recommended unless
the camera is in an area with constant lighting.

B&W: The camera remains in black & white. This setting is not recommended un-
less the camera is in a constantly dark environment.

Under Sensitivity, click + / - or use the slider to set the sensitivity for day / night
switch-over. Setting a lower value means that the camera’s day / night switch-over will
happen in brighter conditions, while a higher value means the switch-over will happen
in darker conditions.

Note
Day & Night must be set to Auto to configure this menu item.

10.6 Focus Setting

Configure how the camera focuses on objects in the image.
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fig File Normal X
WE Focus Mode  Semi Auto i
Exposure Focus Limit  10cm ke
MR Sensiiity Defaut  ~

Day&Night =
IR Correction (©) Enable @ Disable /! Auto
Zoom

Sharpness

Picture

Default

To configure focus settings:

—_

Click Focus to enter the focus setting submenu.
2. Under Focus Mode, select one of the following options:

e Auto: The camera automatically adjusts the focus after it performs a Pan-Tilt-Zoom
function (recommended).

¢ Manual: The camera must be manually put into focus using the NVR menu.

¢ Semi Auto: The camera automatically adjusts the focus after Zoom functions only.

3. Under Focus Limit, select the focus limit for the camera. Set the focus limit between
10CM and 5M to only perform auto-focus on objects further out than the focus limit (for
example, a focus limit of 1M means that the camera will focus on objects further than a
metre away), or select Auto to auto-focus on all objects regardless of their distance
from the camera.

4. Under Sensitivity, select how sensitive you want the automatic focus to be. The lower
the sensitivity, the more difficult it is for objects in the scene to activate automatic focus.

5. Under IR Correction, select Auto to have the image sensor automatically determine
when to use IR correction (recommended), Enable use IR correction at all times, or
Disable to disable IR correction. IR correction is especially effective in night-time
conditions.

10.7 Zoom Setting

Configure digital and optical zoom settings.

e Normal -

»WEB Digital Zoom [

Exposure Zoom Speed [ = | |
NR

Day&Night

g *» Focus

]

Sharpness

Picture

Deefault

To configure zoom settings:

1. Click Zoom to enter the zoom setting submenu.
2. Check Digital Zoom to enable digital zoom on the camera.
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3. Under Zoom Speed, click + / - or use the slider to set the speed of optical zoom
functions.

10.8 Sharpness Setting

Configure image sharpness settings.

afig File . Normal -

WE Sharpness E—O»— g

Exposure Sharpness CNT [=] —O— 5
NR
Day&Night

Focus

Zoom

Ficture

Default

To configure sharpness settings:

1. Click Sharpness to enter the sharpness setting submenu.

2. Under Sharpness, click +/ - or use the slider to set the sharpness of the camera im-
age. The higher the value, the more clear the image becomes. Object edges also be-
come sharper when a higher value is set.

3. Under Sharpness CNT, click + / - or use the slider to set the sharpness control level.

10.9 Picture Setting

Configure the color and appearance of the camera image.

Conditions

Canfig file - Normal -}
ws Style  Standard -
Exposure Hue [=] () [ 50
o Brightness | = | ———{ J—— [+]50

Day&Might

Saturation [=] | o [F] 50
Focus
oo Chroma CNT [=] —E}— 2
Gamma [=| 0— q

Picture Flip

Sharpness |

To configure picture settings:

1. Click Picture to enter the picture setting submenu.
2. Under Style, select one of the following options:

* Standard: Default image style. Sharp, saturated image with vivid colors.
* Soft: Lowers image detail to create a softer image.
* Flamboyant: High saturation with lower sharpness. Designed to reduce eye strain.

3. Under Hue, click the left / right arrow keys to select a hue value for the camera image
(1-100).
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4. Under Brightness, click the left / right arrow keys to select a brightness value for the
camera image (1-100).

5. Under Saturation, click the left / right arrow keys to select a saturation value for the
camera image (1-100).

6. Under Chroma CNT, click the left / right arrow keys to select a chroma suppression
value for the camera image (1-4).

7. Under Gamma, click the left / right arrow keys to select a gamma value for the camera
image (1-16).

8. Check Picture Flip to manually rotate the camera image by 180°.

10.10 Restore Default Settings

Restore the default settings for menu items in the camera conditions menu. You can
choose to reset a selection of submenus from the camera conditions, or reset all values at
the same time.

ConfigFile | Normal ¥

we Cla

osure F
g Flwe {1 Exposure
NR Flnr [l DayaNight
Day&nNight I Focus [Czoom
Focus [“Isharpness | Picture
Zoom
S et

Picture

To restore default settings:

—_

Click Default to enter the factory default submenu.

2. Check the submenus you would like to restore to default settings, or check ALL to re-
set all camera conditions to defaults.

3. Click Default to reset the checked submenus.

Note
This step cannot be undone.
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